
BUKU PETUNJUK PRAKTIKUM

MEDIA PENYULUHAN

PUSAT PENDIDIKAN PERTANIAN
Badan Penyuluhan dan Pengembangan SDM Pertanian
KEMENTERIAN PERTANIAN
2019

•	 Yudi Rustandi, S.ST, M.Si
•	 Andi Warnaen, S.ST, M.Ikom



BUKU PETUNJUK PRAKTIKUM 
POLITEKNIK PEMBANGUNAN PERTANIAN

ISBN : 978-602-
 6367-49-5

PENANGGUNG JAWAB

Kepala Pusat Pendidikan Pertanian

PENYUSUN

Media Penyuluhan

•	 Yudi Rustandi, SST.,M.Si

•	 Andi Warnaen, SST.,M.Ikom

TIM REDAKSI

Ketua : Dr. Ismaya Nita Rianti Parawansa, SP.,M.Si

Sekretaris : Yudi Astoni, S.TP.,M.Sc 

Pusat Pendidikan Pertanian 
Badan Penyuluhan dan Pengembangan Sumber Daya Manusia Pertanian, 

Kantor Pusat Kementerian Pertanian 
Gedung D, Lantai 5, Jl. Harsono RM, No. 3 Ragunan, Jakarta Selatan 12550 

Telp./Fax. : (021) 7827541, 78839234



iMEDIA PENYULUHAN

BUKU PETUNJUK PRAKTIKUM

KATA PENGANTAR

Puji dan syukur kami panjatkan kepada Tuhan Yang Maha Kuasa yang telah 

memberikan rahmat dan karunia-Nya, sehingga penyusunan Buku Petunjuk 

Praktikum dapat diselesaikan dengan baik. Buku Petunjuk Praktikum ini memuat 

Pokok Bahasan, Indikator Pencapaian, Teori, Bahan dan Alat serta Prosedur Kerja. 

Terima kasih kami sampaikan kepada tim penyusun yang telah menyusun 

Buku Petunjuk Praktikum ini serta semua pihak yang telah turut membantu 

dalam penyelesaiannya. Buku Petunjuk Praktikum ditujukan untuk memenuhi 

kebutuhan informasi yang diperlukan oleh para mahasiswa, dosen serta pranata 

laboratorium pendidikan yang akan terlibat dalam proses kegiatan praktikum. 

Diharapkan pelaksanaan dan penyelenggaraan praktikum dapat terlaksana 

lebih baik lagi serta mampu meningkatkan kualitas pembelajaran pada lingkup 

Pendidikan Tinggi Vokasi Pertanian. 

Pada kesempatan ini kami menyampaikan terima kasih kepada semua pihak yang 

telah membantu penyusunan dalam menyelesaikan Buku Petunjuk Praktikum 

ini. Semoga buku petunjuk praktikum ini dapat memberikan manfaat bagi 

mahasiswa, dosen serta pranata laboratorium pendidikan pada Pendidikan Tinggi 

Vokasi Pertanian lingkup Kementerian Pertanian. 

Jakarta,       Oktober 2019

Kepala Pusat Pendidikan Pertanian

Dr. Idha Widi Arsanti, SP.,MP

NIP. 19730114 199903 2 002
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PRAKATA

Menjadi Penyuluh Pertanian Lapangan sebagai  Agent of change yang bekerja 

profesional memerlukan penguasaan terhadap beberapa kompetensi penyuluh 

pertanian seperti yang telah dipersyaratkan oleh SKKNI Penyuluhan Pertanian 

No. 43 Tahun 2013.  Salah satu kompetensi yang harus dikuasai adalah membuat 

dan menggunakan media penyuluhan pertanian. Berlatar belakang  kepada SKKNI 

tersebut maka para PPL dituntut agar menguasai sejak dari tingkat pemahaman 

dan penguasaan secara baik terhadap teknologi media penyuluhan pertanian 

yang berbasis teknologi informasi dalam rangka mengisi era smart society 4.0. 

Penggunaan media di dunia penyuluhan berperan mendukung pelaksanaan 

tupoksi penyuluh dalam penyelenggaraan kegiatan penyuluhan pertanian 

di daerah tugasnya masing-masing. Bagi para penyuluh, media penyuluhan  

merupakan rohnya kegiatan penyuluhan, karena berhasil atau tidaknya informasi 

atau pesan yang disampaikan akan tergantung kepada media yang digunakan 

oleh penyuluh bersangkutan. Baik itu jenis, bentuk, kualitas, desain, maupun 

basis akses dari media yang digunakan akan dapat mempermudah atau 

memperjelas pesan-pesan atau informasi yang disampaikan oleh penyuluh.

Penyuluh pertanian untuk mendapatkan media penyuluhannya bisa melalui : 

1) mencari media yang sudah tersedia dan dapat dimanfaatkan sebagai sumber 

belajar yang tidak secara khusus didesain untuk keperluan pembelajaran namun 

dapat ditemukan, diaplikasikan, dan digunakan untuk keperluan belanja (by 

utilization), dan 2) merancang dan membuat sendiri media penyuluhan sesuai 

dengan kebutuhan merupakan sumber belajar yang dibuat secara sengaja  

untuk keperluan pelaksanaan penyuluhan (by design). Untuk membuat sendiri 

media penyuluhan tentunya para penyuluh dituntut menguasai  pengetahuan 

dan keterampilan dalam merancang/mendesain, membuat dan menggunakan 

media penyuluhan. Dengan demikian para mahasiswa Polbangtan yang nantinya 

berprofesi sebagai penyuluh lapangan harus dibekali dengan pengetahuan dan 

keterampilan dalam merancang (mendesain), membuat dan menggunakan media 

penyuluhan dalam berbagai karakteritik media. Oleh sebab saat ini pengemasan 

media berbasis teknologi informasi, internet dan android sudah menjadi 
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kebutuhan bahkan keharusan maka dalam proses pembelajaran pembuatan 

media penyuluhan yang menjadi konten dalam buku petunjuk praktikum ini juga 

berbasis kepada teknologi informasi, internet dan android. 

Tujuan yang ingin dicapai  dalam penyusunan buku petunjuk praktikum ini adalah 

agar mahasiswa mampu menguasai kompetensi sebagai berikut : 1) memilih 

dan menetapkan media, 2) merancang dan membuat media penyuluhan grafis, 

3) merancang dan membuat media penyuluhan pertanian siaran pedesaan, 4) 

merancang dan membuat media penyuluhan pertanian video/vlog penyuluhan, 

dan 5) merancang dan membuat media penyuluhan pertanian multimedia 

interaktif,

Metode belajar PDCA (Plan, Do, Check, Act.) digunakan secara khusus pada buku 

petunjuk praktikum ini dalam pencapaian kompetensi tersebut. Diharapkan 

dengan matode PDCA ini ketercapain kompetensi mata kuliah Media Penyuluhan 

Pertanian dapat raih secara maksimal pada akhir proses belajar. 

Penyusun
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BUKU PETUNJUK PRAKTIKUM 

MEDIA PENYULUHAN

Minggu ke : I

Capaian Pembelajaran Khusus : Memilih dan Menetapkan media 

penyuluhan pertanian.

Waktu : 1x3x120 menit

Tempat : Lab Media Penyuluhan Pertanian

1.	 Pokok Bahasan :

a.	 Ketersediaan Media Penyuluhan Pertanian 

b.	 Dasar Pertimbangan Pemilihan Media Penyuluhan

c.	 Kriteria Pemilihan Media Penyuluhan Pertanian

d.	 Cara/Prosedur Pemilihan Media Penyuluhan

2.	 Indikator Pencapaian :

a.	 Mahasiswa mampu mengidentifikasi ketersediaan media penyuluhan 

pertanian

b.	 Mahasiswa mampu mengenali beberapa dasar pertimbangan pemilihan 

media penyuluhan

e.	 Mahasiswa mampu  mengenali kriteria pemilihan media penyuluhan pertanian

c.	 Mahasiswa mampu melakukan pemilihan dan penetapan media penyuluhan 

berdasarkan prosedur pemilihan pada SKKNI bidang penyuluhan pertanian.

3.	 Teori :

Setiap media penyuluhan pertanian mempunyai karakteristik tertentu. Dari 

beberapa pengklasifikasian yang sudah ada, bahwa kriteria-kriteria media 

pembelajaran dapat ditinjau dari aspek-aspek, diantaranya: dilhat dari segi 

ekonomisnya, lingkup sasaran yang dapat diliput, kemudahan kontrolnya oleh 
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pemakai, dilihat menurut kemampuan membangkitkan rangsangan seluruh alat 

indera, teknik pembuatannya, dan lain sebaginya.

Materi dan pesan penyuluhan yang disampaikan merupakan penggabungan 

penguasaan ilmu komunikasi, psikologi, sosiologi dan seni, sehingga sasaran 

terpengaruh, termotivasi, dan mau mengadopsi. Karena itu untuk setiap tujuan 

yang berbeda diperlukan media penyuluhan yang berbeda baik dari segi isi 

(materi) maupun kemasan dan perlakuannya. Harapan yang besar tentu saja agar 

media menjadi alat bantu yang dapat mempercepat/mempermudah pencapaian 

tujuan penyuluhan. Ketika suatu media akan terpilih, ketika suatu media akan 

digunakan, ketika itulah beberapa prinsip perlu penyuluh perhatikan dan 

pertimbangkan. 

Ketepatan memilih media dalam penyuluhan sangat bergantung pada 

pengetahuan dan pengalaman penyuluh tentang aneka ragam media, mulai dari 

media sederhana sampai denghan media yang canggih.  Dalam pemilihan media 

penyuluhan di samping kesesuaian dengan tujuan perilaku yang ingin dicapai, 

yang penting juga diperhatikan dalam pemilihan media adalah penguasaan 

penyuluh terhadap kriteria media penyuluhan. Karena apabila salah atau tidak 

ada kesesuaian dalam menentukan kriteria media dengan kegiatan penyuluhan 

yang akan dilakukan, maka tujuan penyuluhan yang telah ditetapkan bisa tidak 

tercapai secara optimal.

4.	 Bahan dan Alat :

No. Bahan dan Alat Gambar
Keterangan/ 

kegunaan

1. Programa 

Penyuluhan 

Pertanian 

Kecamatan, RKTP, 

Dok IPW.

Dokumen data 

kelompoktani
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No. Bahan dan Alat Gambar
Keterangan/ 

kegunaan
2. Dokumen Data 

Karkateritik Sasaran 

Penyuluhan

Sebagai data 

dasar penetapan 

media dan metode 

penyuluhan

3. Media Penyuluhan Ketersediaan media 

penyuluhan

4. Form/Matrik 

Penetapan Media 

Penyuluhan

Membuat analisis 

penetapan media

5. Alat tulis dan kertas Pencatatan

dokumen

6. Komputer/Laptop Dokumentasi hasil 

pemilihan dan 

penetapan

7. Printer Mencetak dokumen

8. LCD Proyektor Presentasi
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5.	 Organisasi :

a.	 Kelompok :

1.	 Pembagian kelompok, masing-masing kelompok berjumlah 3 orang 

2.	 Masing-masing kelompok mendiskusikan materi praktikum yaitu cara/prosedur 

pemilihan dan penetapan media penyuluhan pertanian menggunakan matrik/

form pemilihan dan penetapan media penyuluhan pertanian.

3.	 Masing-masing kelompok menyusun laporan praktek

4.	 Masing-masing kelompok mempresentasikan laporan hasil praktek.

b.	 Individu

Masing-masing mahasiswa menyerahkan tugas pendalaman materi praktikum 

(berdasarkan tugas dan pertanyaan pada point 7 di bawah) berupa makalah 

tentang cara/prosedur pemilihan media penyuluhan pertanian yang memuat 

tentang teori-teori klasifikasi dan kriteria media penyuluhan pertanian, cara atau 

prosedur pemilihan dan penetapan media penyuluhan pertanian.

6.	 Prosedur Kerja

Ikuti tahapan atau langkah-langkah dalam memilih dan menetapkan media 

penyuluhan pertanian, sabagai berikut:

a.	 Pembagian kelompok kerja. 
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Setiap kelompok terdiri dari 3 orang mahasiswa.

b.	 Pahami pengelompokkan media penyuluhan (klasifikasi dan karakterirtiknya)

c.	 Lakukan identifikasi sasaran penyuluhan pertanian berdasarkan profil anggota 

kelompktani, programa penyuluhan pertanian, RKTP, atau dok IPW.

d.	 Kumpulkan data-data sebagai dasar pertimbangan dalam pemilihan media 

penyuluhan berikut: 1) Karakteristik sasaran, 2) Tujuan penyuluhan, 3) Sifat/

jenis materi penyuluhan, 4) Metode penyuluhan yang digunakan, dan 5) 

Teknik komunikasi.

Matrik Dasar Pertimbangan Pemilihan Media

Sasaran 
Penetapan 

Media

Karakterristik Sasaran Pertimbangan Pemilihan Media

Karakteristik
Tujuan 
Penyu-
luhan

Materi 
Penyu-
luhan

Metode 
Yang 

diguna-kan

Jumlah 
Sasaran

Teknik 
Komu-
nikasi

Kelompoktani/
Gapoktan 

Jumlah 

 Orang

1.	 Karakteristik pribadi 

a.	 Jenis Kelamin

b.	 Umur 

c.	 Tingkat 
Pengalaman 
(Usahatani/
ternak)

Topik Materi 
Penyuluhan : 

2. 	Status sosial 
ekonomi

a.	 Tingkat 
Pendidikan

b.	 Tingkat 
Pendapatan 

c.	 Jumlah 
Tanggungan 
Keluarga

d.	 Keterlibatan 
Dalam Kelompok

3.	 Pengalaman 
Beragribisnis
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Sasaran 
Penetapan 

Media

Karakterristik Sasaran Pertimbangan Pemilihan Media

Karakteristik
Tujuan 
Penyu-
luhan

Materi 
Penyu-
luhan

Metode 
Yang 

diguna-kan

Jumlah 
Sasaran

Teknik 
Komu-
nikasi

4. Tingkat Adopsi 
(Sadar, Minat, 
Menilai, Mencoba 
Menerapkan

5.  Perilaku 
keinovatifan 
(Pembaharuan 
/Inovator, 
Penerimaan Awal/
Early adopter, 
penerimaan 
mayoritas awal /
early mojority, 
penerimaan 
mayoritas lambat/
late mojority, 
pengikut/laggard

6.  Moral petani (Moral 
Substensi dan 
Moral Rasionalis)

e.	 Lakukan analisis pemilihan media penyuluhan pertanian menggunakan 

Matrik Analisis Media Penyuluhan Pertanian, sebagai berikut : (data diambil/ 

berdasarkan isian form matrik pertimbangan pemilihan media).

6 MEDIA PENYULUHAN

BUKU PETUNJUK PRAKTIKUM



Matrik Analisa Pemilihan Media Penyuluhan Pertanian

No

Jenis 
Media 
Penyu-
luhan

 Pemilihan Medi Penyuluhan

Jml Per-
ing-kat

Kepu-
tusan 
Pemi-
lihan

Media

Karak-
teristik 
Sasaran

Tujuan 
Penyu-
luhan

Materi 
Penyu-
luhan

Metode 
Yang

Diguna-
kan

Jumlah 
Sasaran

Inpra-
Struk-

tur

•	 Jenis Kelamin: 
•	 Umur
•	 Pendidikan 

..........

..........

..........

..........

..........

..........

..........

..........

..........

..........

..........

..........

..........

..........

..........

1. Poster, Banner, 
Baliho

2. Film layar 
lebar

3. Vidio tutorial

4. Folder/ leaflet

5. Brosur, 

6. Peta singkap

7. Web Site

8. Siaran Pedesaan

9. CD Audio

10. Multimedia

11. Foto 

12. Power point 

13. Model 

14. Sosial Media 
(FB, WA, dll)

15. Televisi

16. Telephone/ HP

F.	 Penetapan media terpilih didasarkan kepada jumlah ceklis tertinggi yang 

selanjutnya dilakukan pemeringkatan. 

7.	 Tugas dan Pertanyaan :

a.	 “Seorang penyuluh pertanian apabila menginginkan dapat menggunakan 

media penyuluhan secara efektif dan efisien harus memahami terlebih dahulu 

karakteristik media penyuluhan”. Jelaskan pernyataan tersebut!

b.	 Berikan penjelasan mengapa penyuluh harus memilih media penyuluhan 

untuk mendukung penyelenggaraan kegiatan penyuluhannya!

c.	 “Ketepatan memilih media dalam penyuluhan sangat bergantung pada 

pengetahuan dan pengalaman penyuluh tentang aneka ragam media, 
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mulai dari media sederhana sampai denghan media yang canggih”. Jelaskan 

pernyataan tersebut!

8.	 Pustaka :

Anonimous, 2008. Pemanfaatan Media Dalam Pembelajaran (Buku Ajar). 

Pendidikan dan Latihan Profesi Guru (PLPG) Sertifikasi Guru Dalam Jabatan 

Tahun 2008. Universitas Negeri Semarang. Semarang.

Arsyad Azhar, 2005. Media Pembelajaran. P.T. Raja Grafindo Persada. Jakarta.

Benny, Dewi, dan Agus. 2005. Ragam Media Dalam Pembelajaran. Buku 2.07. PAU-

PPAI-UT. Jakarta.

Padmowihardjo Soedijanto, Dr. Ir. 2001. Modul Media Penyuluhan Pertanian. Pusat 

Penerbitan Universitas Terbuka. Februari 2001.

Pujiriyanto, 2005. Desain Grafis Komputer (Teori Grafis komputer). Penerbit Andi 

Yogyakarta.

Riyanto Bambang, 1998. Diktat Panduan Praktek Media Penyuluhan Partanian. 

Akademi Penyuluhan Pertanian malang.

Sadiman Arief S. Dr. Msc. Dkk. 1993. Media Pendidikan. Pengertian, Pengembangan, 

dan Pemanfaatannya. PT. Raja Grafindo Persada. Jakarta.

Sudjana Nana, Dr. Rivai Ahmad, Drs. 2005. Media Pengajaran Penggunaan dan 

Pembuatannya. Sinar Baru Algensindo. Bandung.

Sulaeman Amir Hamzah, 1985. Media Audio-Visual Untuk Pengajaran, Penerangan, 

dan Penyuluhan. Penerbit PT Gramedia Jakarta.

9.	 Hasil Praktikum :

a.	 Matrik Dasar Pertimbangan Pemilihan Media dan Matrik Analisis Pertimbangan 

Pemilihan Media (kelompok).

b.	 Makalah (individu).
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MEDIA PENYULUHAN 

Minggu ke : II-V

Capaian Pembelajaran Khusus : Membuat Media Grafis Penyuluhan 

Pertanian

Waktu : 4x3x120 menit

Tempat : Lab Media Penyuluhan Pertanian

1.	 Pokok Bahasan :

a.	 Pengertian, Jenis-Jenis Media Grafis

b.	 Standar Teknis dan Penggunaan Media Grafis 

c.	 Prinsip Dan Tata Letak (Lay Out) Media Grafis

d.	 Teknik Pembuatan Media Grafis.

2.	 Indikator Pencapaian :

a.	 Mahasiswa mampu memahami pengertian, jenis-jenis media grafis, standar 

teknis dan penggunaan media grafis 

b.	 Mahasiswa mampu memahami prinsip dan tata letak (lay out) media grafis

c.	 Mahasiswa mampu merancang  tata letak (lay out) media grafis

d.	 Mahasiswa mampu media grafis penyuluhan pertanian berupa : 1) Folder, 2) 

Leaflet, 3) Brosur, 4) Poster, dan 5) Peta Singkap.

3.	 Teori :

Setiap media mempunyai karakteristik tertentu, baik dilihat dari segi 

kemampuannya, cara pembuatannya, maupun cara pengunaannya. Mengetahui 

standar teknis dan cara penggunannya berbagai media penyuluhan merupakan 

kemampuan dasar yang harus dimiliki para penyuluh pertanian dalam kaitannya 

dengan keterampilan pemilihan, pembuatan media penyuluhan. Di samping itu 

memberikan kemungkinan pada penyuluh untuk menggunakan berbagai jenis 
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media penyuluhan secara bervariasi. Sedangkan apabila kurang memahami 

karakteristik, standar teknis, dan penggunaan media tersebut, para penyuluh 

akan dihadapkan kepada kesulitan dan cenderung bersikap spekulatif.

Untuk mendapatkan ide dasar atau kosep pembuatan media grafis/visual seorang 

penyuluh dapat mengamati bahan-bahan grafis, gambar dan lain-lain yang ada 

disekitar kita, seperti majalah, iklan-iklan (media promosi), papan informasi 

kita akan menemukan banyak gagasan untuk merancang bahan visual yang 

menyangkut penataan elemen-elemen visual yang akan ditampilkan. Dalam 

proses penataan (tata letak/lay out) harus diperhatikan prinsip-prinsip desain 

grafis antara lain: 1)  kesederhanaan, 2)  keterpaduan, 3) penekanan, dan 4) 

keseimbangan. Unsur-unsur visual yang selanjutnya perlu dipertimbangkan 

adalah bentuk, garis, ruang, tekstur dan warna.

Hal-hal penting yang perlu diperhatikan dalam tahapan atau langkah-langkah 

pembuatan media grafis penyuluhan pertanian adalah : 1) pembuatan konsep 

awal, 2) mengikuti ketentuan-ketentuan atau petunjuk pelaksanaan, dan 

prinsip-prinsip desain grafis, 3) persiapan alat dan bahan yang diperlukan, 5) 

pelaksanaan pembuatan media grafis, dan 5) melakukan evaluasi media grafis 

menggunakan beberapa model evaluasi media.

4.	 Bahan dan Alat :

No. Bahan dan Alat Gambar Keterangan/ kegunaan

1. Alat tulis dan buku 
tulis

Membuat outline dan 
lay out secara manual

2. Jenis-Jenis Kertas Bahan mencetak media 
folder. Leaflet, dll.
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No. Bahan dan Alat Gambar Keterangan/ kegunaan

3. Gunting,staples, 
Lakban, Lem 
kertas, dan 
lainnya

Bahan pendukung 
pembuatan media

4. Komputer/Laptop Menjalankan aplikasi 
grafis 

5. Printer Mencetak naskah dan 
media grafis

6. Aplikasi
a.	 Corel Draw
b.	 Photo Shop
c.	 Adobe 

Illustrator

Membuatan media 
berbasis grafis

7. Foto-Foto dan 
Animasi

Gambar pendukung/
memperjelas teks

8. LCD Proyektor Presentasi

5.	 Organisasi :

a.	 Kelompok

1.	 Pembagian kelompok, masing-masing kelompok berjumlah 3 orang.

2.	 Masing-masing kelompok mendiskusikan materi praktikum yaitu: 1) 

merancang tata letak (lay out) media grafis dan membuat media grafis 

penyuluhan pertanian berupa : 1) Folder dan Leaflet,  2) Brosur, 3) Poster, dan 

4) Peta Singkap.
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3.	 Masing-masing kelompok membuat laporan pelaksanaan praktikum 

pembuatan media grafis.

4.	 Masing-masing kelompok mengumpulkan hasil produksi pembuatan media 

grafis berupa: 1) Folder dan Leaflet, 2) Brosur, 3) Poster, dan 4) Peta Singkap  

pada dosen pengampu mata kuliah.

b.	 Individu :

1.	 Setiap mahasiswa melakukan pendalam materi tentang media grfais 

penyuluhan pertanian (tugas mandiri).

2.	 Materi pendalaman (berupa pertanyaan dan tugas) dapat dilihat pada poin 

sub bab 7 di bawah.

3.	 Setiap mahasiswa membuat laporan berupa tulisan/makalah hasil pendalaman 

materi media grafis penyuluhan pertanian.

4.	 Makalah diserahkan kepada dosen pengampu mata kuliah.

6.	 Prosedur Kerja :

Gambar Prosedur Kerja Pembuatan Media Video/Vlog Penyuluhan Pertanian

Langkah kerja dalam produksi media grafis, sebagai berikut :

a.	 Pembentukan Kelompok Kerja.

Pekerjaan ini dilaksanakan oleh kelompok sebanyak 3 orang.

12 MEDIA PENYULUHAN

BUKU PETUNJUK PRAKTIKUM



b.	 Melakukan identifikasi kebutuhan media dengan menggunakan prosedur 

pemilihan media penyuluhan.

c.	 Membuat konsep media penyuluhan yang akan dibuat. 

Contoh dalam pembuatan media folder sebagai berikut :

d.	 Buatlah rancangan tata letak (lay out) dari media grafis yang akan dibuat. 

Contoh Layout Poster :  “Beternak Kelinci Unggul”, sbb :
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e.	 Pelajari terlebih dahulu ketentuan-ketentuan pembuatan media penyuluhan 

dari standar teknis pembuatan media penyuluhan pertanian. 

(Lihat modul Media Penyuluhan Pertanian)

f.	 Pelaksanaan : 

Contoh: Tahapan pembuatan folder menggunakan Software Corel Draw

1)	 Untuk memulai membuka lembar kerja Corel Draw klik, New blank document

2)	 Tampilan lembar kerja Corel Draw

3)	 Memilih ukuran kertas, orientasi kertas dan satuan ukuran
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4)	 Klik Rectangle Tool pada Toolbox, kemudian drag buatlah persegi panjang di 

lembar kerja

5)	 Kemudian pada Object (s) Size di Property Bar , atur ukuran 30 X 21 cm

6)	 Dari sudut perpotongan Ruler horizontal dan vertikal. Klik tahan dan tarik 

(drag) hingga menyentuh sudut kiri atas objek persegi panjang.

7)	 Klik menu View > Guidelines

Kemudian tarik guidelines untuk membatasi bidang halaman brosur. Gunakan 

dua guidelines, arahkan tepat pada ukuran Ruler Horizontal 10 dan 20 cm

15MEDIA PENYULUHAN

BUKU PETUNJUK PRAKTIKUM



8)	 Aktifkan objek persegi panjang. Klik Fill Tool > Fountain Fill di Toolbox.

9)	 Pada kotak Fountain Fill pilihlah Type : Radial, kemudian di bagian Bend Color 

pilih Two Color pada From : Gost Green  dan  To : Orange, dengan Midpoint : 

25.

Klik OK

16 MEDIA PENYULUHAN

BUKU PETUNJUK PRAKTIKUM



10)	 Merias bidang Folder dengan Artistic Media.

Klil Artistic Media Tool pada Toolbox. Pada Property Bar pilih modus Artistic 

Media Tool type Sprayer.  Lalu atur pada Freehand, Smothing : 61 dan Size Of 

Object (s) to be Sprayed : 30 % dan 90 %.

11)	 Masih dalam Property Bar, pada Spraylist File List pilih bentuk Baloon atau 

Mashroom
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12)	 Tariklah garis artistik pada bidang kerja (Folder).

Kemudian Klik

13)	 Tampilan Artistic Media Tool

14)	 Melengkapi Folder (bidang kerja) dengan Ornamen. Klik Freehand Tool pada 

Toolbox, buatlah ornament persegi panjang di again bawah.
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15)	 Klik Interactive Blend Tool untuk mengaktifkan Interactive Envelope Tool.

16)	 Aturlah lengkungan garis-garis persegi panjang itu pada bagian atas sehingga 

membentuk garis lengkung naik turun.

Dengan mengaktifkan Rectangle, kemudian rubahlah warnanya menjadi warna 

ungu.

17)	 Hilangkan garis dengan Outline Pen. Pilih None dan klik.
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18)	 Menjadikan transfaran Ornamen yang telah dibuat. 

Aktifkan terlebih dahulu dengan meng-klik Interactive Blend Tool, pilihlah 

Transparancy Tool.

19)	 Klik Rectangle kemudian buatlah objek persegipanjang ukuran 10 X21 cm. 

tempatkan pada bidang  Folder sepertiganya (1/3) sebelah kanan.
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20)	 Buatlah menjadi transfaran dengan cara Aktifkan terlebih dahulu dengan 

meng-klik Interactive Blend Tool, pilihlah Transparancy Tool.

21)	 Membuat Judul Folder.

Klik Text Tool pada Toolbox kemudian atus Font  dan ukurannya. 
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22)	 Ketik BETERNAK BURUNG PELIKAN. Kemudian klik Aligenment Centre, untuk 

pengaturan posisi teks.

23)	 Menampilkan gambar.

Klik menu File > Import untuk menampilkan gambar Burung Pelikan. Pada kotak 

dialog import pada Look In: buka folder koleksi gambar kemudian pilih gambar 

Burung Pelikan.
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24)	 Tampilan gambar dengan masih terlihat bidang putihnya perlu dihilangkan 

agar terlihat menyatu dengan latar belakang folder. 

Klik  Edit Bitmap, kemudian klik Outline Trace, selanjutnya pilih Cliptart.

Klik OK.

25)	  Tampilan setelah Edit Bitmap. 
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26)	 Klik Delete pada keyboard untuk menghapus gambar burung pelican yang 

masih terlihat warna putih perseginya.

27)	 Lengkapilah teks STPP MALANG 2010, dengan cara sebelumnya (nomor 21 & 

22)
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28)	 Jadikan transfaran pada bidang kotak kedua (sebelah kanannya) dengan cara 

seperti pada nomor 20.

29)	 Buatlah teks pada bidang kotak ke dua folder. 

Bukalah file Tips Memuaskan Wanita Di Atas Ranjang dari Word, kemudian 

sorotlah sesuai keperluan.
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30)	 Klik di bidang kotak ke dua.

31)	 Klik dua kali pada teks hasil Copy-Paste tadi, sehingga terjadi perubahan 

menjadi Work Sheet di World.  Editlah teks yang terdapat di Work Sheet 

sesuai kebutuhan.
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32)	 Rubahlah ukurannya disesuaikan dengan besarnya bidang kotak ke dua. 

Sesuaikan Teks Aligment-nya. Buatlah Drop Cap pada awal paragraf pertama 

yaitu pada huruf “S”. Ubahlah warna huruf tersebut. Kemudian  Klik.

33)	 Ulangi pekerjaan sebelumnya (nomor 28 s/d 32) untuk mengisikan teks pada 

bidang kotak ketiga.
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34)	 Lakukan pengaturan seperti sebelumnya untuk mengisi lembaran folder 

bagian belakang.

35)	 Pilihlah Print Preview pada File.
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36)	 Pilihlah Fit to Page dari Image Position Within Page, untuk mengatur posisi 

menyesuaikan area print.

37)	 Pilihlah Layout pada menu Setting di Toolbar.
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38)	 Agar proses print (mencetak lebih cepat), harus diatur terlebih dahulu besaran 

pixelnya dengan cara, sbb :

Pilih Setting, selanjutnya pilih General, kemudian pilih Misc, lalu pilih Bitmap 

Downsampling dengan mengklik pada tulisan Color dan masukkan nilai antara 

100-150, selanjutnya pilih Ok.

39)	 Pilihlah Propertis dari Print Option
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40)	 Pilihlah menu Page Setup dari Canon 1800 Series Propertis. Selanjutnya klik 

Page Size dan pilih ukuran kertas A4. Klik OK.

41)	 Pilihlah menu File di Toolbar. Klik menu Print. Tunggulah Proses print sampai 

selesai.

g.	 Testing (uji coba) multimedia Interaktif

1)	 Lakukan tahap pertama, pada tahap ini disebut juga sebagai tahap pengujian 

alpha (alpha test) yang pengujiannya dilakukan oleh pembuat atau lingkungan 

pembuatnya sendiri.
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	Pada tahap ini, salah satu metode yang dugunakan adalah dengan dilakukan 

pengujian menggunakan blackbox testing (Pengujian berfokus pada 

persyaratan fungsional perangkat lunak). 

	Contoh : Tabel Pengujian Blackbox Testing

Aktivitas Pengujian Hasil diharapkan Hasil Pengujian Kesimpulan

Font teks Arial 11 pt Arial 11 pt [ x ] Diterima

[    ] Ditolak

Dst …

	Lakukan pengujian apabila hasil masih ditolak (tidak sesuai hasil yang 

diharapkan)

2)	 Lakukan tahap pengujian beta yang dilakukan dan melibatkan penggunaan 

akhir. 

	Pada tahap ini, salah satu metode yang dugunakan adalah dengan dilakukan 

pengujian menggunakan Model Evaluasi Sadiman

	Contoh : Model Model Evaluasi Sadiman

7.	 Tugas dan Pertanyaan :

Untuk memperdalam uraian materi Media Grafis Penyuluhan Pertanian, 

lakukanlah kegiatan berikut :
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a.	 Setiap mahasiswa ditugaskan untuk :

1)	 Pelajari dan pahami uraian materi pada Modul Media Penyuluhan Pertanian!

2)	 Amati contoh Media Grafis Penyuluhan Pertanian berupa folder, leaflet, 

brosur, peta singkap, dan poster.

3)	 Jawablah pertanyaan-pertanyaan, sebagai berikut :

a)	 Media grafis yang telah diamati tadi, termasuk kepada bentuk media grafis 

apa?  ……………………………………………………………………………………………

Alasan : ……………………………………………………………….....................................

……………………………………………………………………………………………………………….

b)	 Apakah isi materi yang disampaikan sudah sesuai dengan judul ? …………

Alasan : ……………………………………………………………….....................................

………………………………………………………………………………………………………………

c)	 Bagaimana caranya menentukan tujuan, pengguna dan judul Media Grafis 

penyuluhan yang akan digunakan di daerah (wilayah) yang akan menjadi 

lokasi penyuluhan ?

Caranya : ………………………………………………………………………………...................

……………………………………………………………………………………………………………….

d)	 Apakah isi materi Media Grafis penyuluhan yang diamati sudah sesuai dengan 

tujuan yang ingin dicapai ? ………………………………………………………..

Alasan : ……………………………………………………………….....................................

e)	 Apakah informasi yang disampaikan pada Media Grafis penyuluhan tersebut 

mudah dipahami ? ……………………………………………………………………

Alasan : ……………………………………………………………….....................................

……………………………………………………………………………………………………………..

f)	 Apakah inovasi teknologi yang menjadi bahan informasi pada Media Grafis 

penyuluhan tersebut dapat diterapkan oleh sasaran (petani) ? ………………..

Alasan : ………………………………………………………………........................................

……………………………………………………………………………………………………………….
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g)	 Apakah cara penyajian (pengemasan) Media Grafis penyuluhan tersebut  

sudah sesuai dengan sasaran pengguna ? ……………………………

Alasan : ……………………………………………………………….....................................

……………………………………………………………………………………………………………….

h)	 Apakah kualitas warna teks dan gambar pada media grafis penyuluhan 

tersebut sudah bagus dan sesuai dengan sasaran  ? …………………………………

Alasan : ………………………………………………………………........................................

……………………………………………………………………………………………………………….

i)	 Apakah besarnya teks dan gambar pada media grafis penyuluhan tersebut 

sudah bagus dan sesuai dengan sasaran  ? ……………………………………………….

Alasan : ………………………………………………………………........................................

..……………………………………………………………………………………………………………..

j)	 Apakah teknik penyusunan isi materi pada media grafis penyuluhan tersebut 

sudah baik dan benar ? ……………………………………………………………..

Alasan : ……………………………………………………………….......................................

………………………………………………………………………………………………………………

b.	 Deskripsikan (berikan gambaran) berupa tulisan hasil jawaban tersebut !

8.	 Pustaka :
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dan Pemanfaatannya. PT. Raja Grafindo Persada. Jakarta.
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Pembuatannya. Sinar Baru Algensindo. Bandung.
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9.	 Hasil Praktikum :

a.	 Kelompok : Media penyuluhan grafis, berupa : 1)  Folder, 2) Leaflet, 3) Brosur, 

4) Poster, dan 5) Peta singkap.

b.	 Individu : Makalah/tulisan. 
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BUKU PETUNJUK PRAKTIKUM 

MEDIA PENYULUHAN

Minggu ke : VI-VII

Capaian Pembelajaran Khusus : Mampu memahami dan membuat media 

radio penyuluhan pertanian

Waktu : 2x3x120 menit

Tempat : Lab Media Penyuluhan Pertanian

1.	 Pokok Bahasan :

a.	 Penulisan Naskah Siaran Pedesaan

b.	 Prosedur Pembuatan Siaran Pedesaan.

2.	 Indikator Pencapaian :

a.	 Mahasiswa mampu memahami, merancang  out line siaran pedesaan

b.	  Mahasiswa mampu membuat naskah siaran pedesaan.

c.	 Mahasiswa mampu menguasai prosedur produksi siaran pedesaan

d.	 Mahasiswa mampu memproduksi siaran pedesaan dalam bentuk beberapa 

acara siaran pedesaan.

e.	 Mahasiswa mampu bekerjasama dengan statsiun radio untuk menyiarkan 

siaran pedesaan yang telah diproduiksinya.

3.	 Teori :

Radio dan televisi dapat dikelompokkan sebagai media yang menguasai ruang 

tetapi tidak menguasai waktu, sedangkan media cetak menguasai waktu tetapi 

tidak menguasai ruang.  Artinya siaran dari media televisi atau radio dapat 

diterima dimana saja dalam jangkauan pancarannya (menguasai ruang) tetapi 

siarannya tidak dapat dilihat kembali. Salah satu siaran radio yang telah lama 

dikenal oleh masyarakat pedesaan (petani) yaitu Acara Siaran Pedesaan. Acara 

Siaran Pedesaan ini diantaranya disiarkan oleh RRI dan RSPD di daerah/wilayah 

masing-masing.
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Siaran pedesaan melalui radio adalah siaran khusus yang ditujukan bagi para 

petani dan keluarganya dengan maksud menyebarkan secara cepat informasi-

informasi dan pengetahuan baru dibidang pertanian seluas-luasnya. Dengan 

mengorganisasikan kelompok pendengar maka efektivitas penangkapan 

informasi ditingkatkan sehingga memungkinkan terjadinya adopsi. Metode siaran 

pedesaan tidak bisa berdiri sendiri. Ia hanya efektif sebagai penunjang metode-

metode lain. Siaran pedesaan selain melalui radio juga dapat dilakukan melalui 

televisi.  

Tujuan penyelenggaraan siaran pedesaan dalam kegiatan penyuluhan pertanian 

adalah : a) Membangkitkan kesadaran dan perhatian, b) Menumbuhkan 

minat dan keingintahuan, c) Menyebarluaskan informasi secara tepat dan 

meluas, d) Menyabarluaskan pengertian teknologi baru dibidang pertanian, 

e) Membangkitkan kesadaran dan perhatian akan pentingnya pemeliharaan 

kelestarian sumberdaya alam, teknologi baru, pemasaran hasil, f) Mendorong 

minat untuk meningkatkan produksi pertanian dalam hal kuantitas dan 

kualitas, dan g) Membangkitkan apresiasi dan sikap positif terhadap kegiatan 

pembangunan pertanian.

4.	 Bahan dan Alat :

No. Bahan dan Alat Gambar Keterangan/ kegunaan

1. Alat tulis dan buku 

tulis

Membuat outline dan 

lay out secara manual

2 Materi penyuluhan Bahan (konten) 

informasi siaran 

pedesaan 

4. Komputer/Laptop Mengetik naskah dan 

Menjalankan aplikasi 

pengolah audio 
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No. Bahan dan Alat Gambar Keterangan/ kegunaan

5. Printer Mencetak naskah 

Siaran Pedesaan

6. Aplikasi AVS audio 

recorder dan AVS 

Audio Editor

Pengolah audio 

menjadi sisran 

pedesaan

7. Musik Sebagai music 

pembuka, pengiring, 

latar.

8. Sound Effect Menguatkan Susana 

yang diciptakan

9. Studio Rekaman Merekam audio

5.	 Organisasi :

a.	 Kelompok

1.	 Pembagian kelompok, masing-masing kelompok berjumlah 3 orang.

2.	 Masing-masing kelompok mendiskusikan materi praktikum yaitu : 1) teknik 

pelaksanaan siaran pedesaan dan 2) prosedur produksi siaran pedesaan.

3.	 Masing-masing kelompok membuat laporan pelaksanaan praktikum 

pembuatan media radio siaran pedesaan.

4.	 Masing-masing kelompok mengumpulkan hasil produksi pembuatan media 

radio/siaran pedesaan berupa: 1) naskah siaran pedesaan, dan 2) hasil 

produksi siaran pedesaan dalam bentuk acara siaran pedesaan tertentu.
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b.	 Individu
1.	 Setiap mahasiswa melakukan pendalam materi tentang siaran radio dan siaran 

pedesaan (tugas mandiri). Lihat tugas dan pertanyaan sub bab 7 di bawah ini.

2.	 Setiap mahasiswa membuat laporan berupa makalah hasil pendalaman ma-
teri tentang siaran radio dan siaran pedesaan.

3.	 Makalah diserahkan kepada dosen pengampu mata kuliah.

6.	 Prosedur Kerja :

Gambar Prosedur Kerja Pembuatan Media Video/Vlog Penyuluhan Pertanian

a.	 Merencanakan pelaksanaan penyiaraan dengan stasiun radio (RRI atau 

RSPD), sebagai berikut : 

1)	 Lakukanlah kerjasama dengan stasiun radio, RRI, RSPD, radio lokal atau radio 

komunitas.

2)	 Mintakan jam siaran yang sesuai dengan kebiasaan dan waktu senggang dari 

pendengar

3)	 Waktu siaran tidak perlu panjang: 5 sampai 10 menit sudah cukup (seluruh 

acara siaran biasanya 30 menit)

4)	 Ajak penyelanggara siaran ke desa atau tempat kelompok pendengar untuk 

melakukan wawancara dengan mereka. Hasilnya disiarkan.

5)	 Bahan-bahan yang akan disiarkan hendaknya memenuhi persyaratan:
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a.	 Mudah dimengerti

b.	 Melingkupi satu masalah saja.

c.	 Bahasanya sederhana

d.	 Singkat tetapi lengkap

e.	 Tidak menyiarkan terlalu banyak masalah ketrampilan melainkan lebih banyak 

pengetahuan umum

f.	 Gunakan bahasa yang dapat atau mudah dimengerti

g.	 Hangat (actual)

h.	 Bersifat memecahkan masalah

i.	 Terjamin kebenarannya

b.	 Memproduksi Siaran Pedesaan, sebagai berikut :

1)	 Lakukan identifikasi potensi wilayah atau need assesment, yaitu dengan 

melaksanakan penelitian atau observasi tentang keadaan sasaran pendengar 

untuk bisa mengungkap tentang minat dan kebutuhan, tingkat pengetahuan, 

sikap, dan penentuan format atau bentuk naskah.

2)	 Pelajari beberapa istilah atau petunjuk dalam menulis naskah siaran pedesaan 

yaitu : bahasa, musik, daya konsentrasi.

3)	 Pelajari beberapa istilah dan singkatan dalam naskah audio, seperti : ANN, 

NARR, FX, dan lainnya.

c.	 Ikuti prosedur pembuatan siaran radio, berikut :

Tahap Pra-Produksi:

1)	 Pemilihan topik yang tepat

2)	 Penentuan bentuk siaran yang sesuai (uraian, dialog, drama, atau yang lainnya)

3)	 Studi pustaka/survei lapangan (bila diperlukan)

4)	 Pembagian tugas dan tanggung jawab tim (organisasi produksi)

	produser
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	sutradara

	asisten sutradara

	penulis naskah siaran pedesaan

	Pemain, narator, dsb.

5)	 Pengumpulan data

6)	 Persiapan perangkat-perangkat untuk produksi/penayangan (live)

Tahap Produksi :

1)	 Pengolahan data

2)	 Pengambilan suara (untuk rekaman)

3)	 Penyusunan naskah jadi.

(contoh potongan naskah siaran pedesaan) berikut :

PEMOTONGAN BULU DOMBA
POKOK BAHASAN 	 : Perawatan Ternak Domba  
FORMAT SAJIAN	 : Dialog (Percakapan) 
PENULIS		  : Kelompok IV NAK B-2005 
PRODUKSI 		  : Studio Lab. Media Penyuluhan STPP 
Malang

NO. PELAKU TEKS/JENIS SUARA

01. MUSIK IN-UP-DOWN-UNDER 

02. ANN CAMPUR SARI (SAYANG-SAYANG)

Selamat pagi para pendengar setia, inilah Radio 
Penyuluhan Pertanian STPP Malang. Dipancarluaskan 
pada gelombang FM 89,90 Mgz dari Lantai Dua Gedung 
Lab. Media Penyulhan STPP Malang.

IN-UP-DOWN-OUT

03. MUSIK CAMPUR SARI (SAYANG-SAYANG)
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04. NARR Pendengar yang berbahagia, selamat berjumpa 
kembali dalam acara yang sedang bapak ibu tani 
nanti-nanti yaitu siaran pedesaan. Semoga kehadiran 
kami pada pagi hari ini dapat menambah keceriaan 
suasana  keluarga anda. Kali ini siaran pedesaan akan 
menghadirkan topik tentang “Pemotongan Bulu 
Domba”.

07. MUSIK IN-UP-DOWN OUT

08. NARR CAMPUR SARI (PRAHU LAYAR)

09. MUSIK Pendengar setia dimanapun anda berada, seperti 
kita ketahui seringkali pada domba yang kita 
pelihara muncul kutu-kutu pada bulunya. Hal ini bisa 
disebabkan karena perawatan dan sanitasi yang kurang 
baik. Nah, salah satu cara untuk mencegah munculnya 
kutu ini adalah dengan melalui pemotongan bulu. 
Untuk lebih jelasnya mari kita ikuti percakapan berikut 
ini.

10. FX IN-UP-DOWN-OUT

11. PAK TRI CAMPUR SARI (PRAHU LAYAR)

12. BU TRI SUARA AYAM BERKOKOK DAN SUARA MENCUCI PIRING 
DIDAPUR

13. FX Bu…Bu… tolong buatkan bapak minuman, yah

14. BU TRI (OFF MIKE) Iya… tunggu sebentar ya… Ini juga sedang 
disiapkan. 

15. PAK TRI Klitik  Klitik …. SUARA MENGADUK MINUMAN

16. FX (FADE IN) Ini Pak kopinya, saya taro diatas bangku saja 
yah …

17. BU TRI Iya, taruh aja di situ, biar ngak ke senggol anak domba.

18. PAK TRI SUARA MELETAKKAN GELAS DIATAS BANGKU

19. BU TRI Kenapa to Pak, pagi-pagi kok sudah termenung. Bapak 
ini sedang mikirin apa to ?

20. PAK TRI Itu, lho Bu. Domba-domba kita itu dari kemaren kok 
kutuan terus, aku takut kalau lama-lama domba kita 
menjadi kurus.
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21. PAK TRI +BU 
TRI/

Lha terus bagaimana cara mengatasi kutu-kutu itu  Pak 
?

22. FX Itu yang belum aku tahu sampai sekarang, Bu.

23. BU TRI

…………

HENING 20 DETIK …….. YANG TERDENGAR HANYA 
SUARA DOMBA DAN AYAM.

SETENGAH BERTERIAK… Aku ada ide Pak ! Bagaimana 
kalau bapak pergi ke rumah Pak Nahrowi, PPL 
peternakan itu lho, yang rumahnya dekat Pos Kamling. 
Siapa tahu beliau bisa memberikan jalan keluarnya.

Eehm…… Ibu bener juga yah. Baiklah pagi ini juga akan 
ke rumah Bapak PPL kita, untuk menanyakan masalah 
ini.

Berlanjut ……..  s/d selsai

d.	 Produksi audio dengan cara merekam naskah oleh seluruh personel produksi 

yang terlibat.

1)	 Persiapan studio

	 Peralatan rekaman

	Aplikasi rekaman (AVS Audio Rocorder)

2)	 Persiapan personel dan rekaman 

	produser

	 sutradara

	 asisten sutradara

	 Pemain 

	Narator

	Operator, dsb.

3)	 Perekaman

Merekam audio menggunakan aplikasi AVS Audio Rocorder.
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Tahap Produksi 

1)	 Editing

Membuka File pada AVS Audio Editor

Membuka File Audio

Untuk mulai mengedit file, Anda harus memuatnya ke salah satu aplikasi edit 

audio yaitu; AVS Audio Editor. Ada beberapa cara untuk melakukannya: (www.

avs4you.com, 2004-2011).

a)	 Cara termudah untuk menambahkan file ke program adalah klik kanan dengan 

mouse dan pilih opsi AVS Edit Audio dari menu konteks.

Dengan cara ini Anda dapat membuka audio dan mengimpor video untuk 

mengedit trek audionya.

b)	 Pilih tombol perintah Buka  pada Home Tab atau File Tab. Jendela berikut 

akan dibuka:
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Anda dapat memilih file atau beberapa file dengan mouse atau keyboard dan klik 

tombol Open.   

c)	 Pilih tombol perintah Open  sebagai     pada Home Tab atau File Tab (opsi 

Open as... akan ditampilkan setelah Anda menekan panah di sebelah tombol 

Open button). Opsi ini akan memungkinkan Anda membuka file seolah-olah 

itu format yang berbeda dari yang sebenarnya (disebut metode konversi 

«cepat dan mudah»). Setelah Anda memilih file atau beberapa file di jendela 

di atas, Anda akan ditawari untuk mengatur parameter berikut:
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Pilih Sample Rate (8’000 - 96’000 Herz), Sample Size  (8-bit - 32-bit) dan jumlah 

Channels (1/0 - mono - 3/4 + LFE 7.1 surround) dan klik Tombol OK untuk dengan 

cepat mengkonversi file yang diedit ke dalam format yang dipilih.

 Catatan: file asli tidak akan dikonversi kecuali Anda memutuskan untuk 

menyimpannya. AVS Audio Editor membuka semua file ke dalam format 

sementara dan menyimpan semua perubahan ke file asli hanya ketika Anda 

memilih untuk Simpan dengan menggunakan salah satu cara.

d)	 Pilih tombol perintah Open and Append  pada Home Tab atau File Tab 

(opsi Open and Append... akan ditampilkan setelah Anda menekan panah di 

sebelah tombol Open). Opsi ini akan memungkinkan Anda membuka file dan 

menambahkannya ke file yang sudah dibuka membuat satu file dari dua. File 

akan digabung menjadi satu dengan file yang dibuka kedua ditambahkan ke 

akhir yang dibuka pertama.

AVS Audio Editor mendukung semua format audio populer. Lihat bab Format 

Audio yang Didukung untuk melihat daftar format yang didukung. Saat Anda 

memuat file untuk diedit, AVS Audio Editor mengubah tipe gelombang ke jenis 

file sementara internal untuk mengedit lebih cepat dan penanganan yang lebih 

baik dari ukuran file yang lebih besar.

Membuka File Video

Anda dapat mengimpor file video ke AVS Audio Editor dengan tujuan mengedit 

trek audionya. Anda dapat membuka file video dengan format berikut:

•	 AVI Files (.avi, .ivf, .div, .divx)

•	 Mpeg Files (.mpg, .mpeg, .mod, .mpe, .mvv)

•	 Quick Time Files (.mov, .qt, .m4v, .mp4)

•	 Mobile Video (.3gp2, .3gpp, .3g2, .3gp)

•	 AVCHD (.mts, .tod)

•	 Flash Video (.flv)
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Untuk membuka file video, pilih tombol perintah Open...    pada Home Tab 

atau File Tab.. Jelajahi file video yang diperlukan (pastikan opsi All Video Files  

dipilih di jendela yang terbuka) dan tekan Open. File video yang dipilih akan 

ditambahkan ke bagian File di Files and Effects Panel:

Jika file video yang Anda impor berisi beberapa trek audio, Anda akan diberikan 

jendela berikut:

•	 Pilih trek audio yang diperlukan dan tekan OK. File video dengan trek audio 

yang dipilih akan diimpor ke dalam program.

•	 Anda dapat mengedit trek audio dari file video Anda seperti halnya trek audio 

apa pun yang dimuat ke dalam program. Harap perhatikan bahwa.

•	 Anda dapat menerapkan sejumlah efek ke trek audio Anda. Editor Audio AVS 

tidak akan memungkinkan Anda untuk menerapkan efek yang mengubah 

durasi trek dan menghasilkan suara.

•	 Saat saving file video Anda, Anda akan dapat mengubah format trek audionya. 

Hasilnya akan disimpan sebagai file video dengan trek audio yang diedit dari 

format audio yang dipilih.
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Editing Mix Project

Semua trek audio yang Anda tambahkan akan ditampilkan dalam Mix Timeline 

yang membantu mengelola file Anda dan mengeditnya.

Mengubah Posisi File Audio

Semua trek audio yang ditambahkan untuk pencampuran ditempatkan satu 

di bawah yang lain secara default. Ini berarti mereka akan diputar ulang secara 

bersamaan. Anda dapat mengubah posisi trek audio apa pun dengan menyeret. 

File dapat diseret sepanjang garis aslinya atau ditempatkan ke baris lain di bawah 

atau di atas.

Klik dengan tombol kiri mouse di dalam blok trek audio dan gerakkan ke atas atau 

ke bawah untuk mengubah urutan file, atau memindahkannya ke kiri / kanan 

untuk mengubah posisi file dalam baris aslinya.

Memotong File Audio

Untuk memotong awal atau akhir trek audio, seret batasnya ke dalam.
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Membagi File Audio dan Menghapus Bagian

Untuk membagi trek audio menjadi beberapa bagian, letakkan kursor di tempat 

Anda ingin file tersebut dipecah dan klik tombol perintah Split Object pada Mix 

Tab atau gunakan opsi yang sesuai dari menu klik kanan.

Setelah itu Anda dapat menghapus beberapa bagian yang tidak diinginkan 

memilihnya dengan mouse dan mengklik tombol perintah Delete Object   pada 

Mix Tabatau menggunakan opsi yang sesuai dari menu klik kanan.
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Mengatur Volume dan Saldo File Audio

Untuk menyesuaikan volume dan keseimbangan file audio gunakan bilah geser 

yang sesuai di sebelah kiri garis yang dipilih. Anda juga dapat membisukan file 

audio yang dipilih atau menonaktifkan semua file audio kecuali yang dipilih 

dengan mengklik tombol Mute atau Solo  dengan respek.

Untuk menyesuaikan volume dan keseimbangan whole campuran audio, gunakan 

the sliding bars (bilah geser) grup tombol Mix Volume pada the Mix Tab.

Memasukkan Rekaman Audio

Untuk menyisipkan beberapa tempat rekaman suara, kursor mouse di dalam 

garis Audio Recording  dari Mix Timeline tempat Anda ingin memulai perekaman 

dan klik tombol Record di sebelah kiri.

Menerapkan Efek

Untuk menerapkan efek ke campuran audio Anda, klik tombol efek yang 

diperlukan pada Mix Tab. Efeknya akan ditambahkan ke garis Audio Effect   dari 

Mix Timeline. Efek yang diterapkan hanya mencakup sebagian dari campuran 

Anda secara default. Anda dapat mengubah area aplikasi efek dengan menyeret 

batas-batasnya.
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Untuk mengubah properti efek yang diterapkan, klik dua kali pada Mix Timeline. 

Ini akan membuka jendela properti efek. Untuk mempelajari lebih lanjut tentang 

mengonfigurasi parameter dari beberapa efek tertentu, silakan merujuk ke 

halaman efek yang sesuai di bagian Using Effects and Filters .

Untuk menghapus efek, gunakan tombol perintah Delete Object   pada Mix Tab 

atau klik kanan efek dan pilih opsi yang sesuai dari menu klik kanan.

Catatan: efeknya akan diterapkan ke SEMUA trek audio yang digunakan 

dalam campuran audio Anda.

Ketika campuran siap gunakan tombol Playback pada Bilah Bottom Toolbar 

untuk memeriksa hasil pekerjaan Anda.

Menyimpan Proyek Mix

AVS Audio Editor memungkinkan Anda untuk mengekspor campuran audio yang 

Anda buat ke file audio atau hanya menyimpannya ke file .mix project file.

Saving to a Project File

Menyimpan ke Project File (File Proyek)

Menyimpan campuran audio ke file proyek memberi Anda kemungkinan untuk 

kembali lagi nanti dan membuat beberapa perubahan lebih lanjut. Untuk 

melakukan itu klik tombol Save Project   dari grup tombol Mix Project  . Jendela 

berikut akan dibuka:
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Ketik nama untuk proyek Anda di bidang File Name  , pilih lokasi proyek dari 

daftar Folder drop-down  dan klik tombol Save.

File proyek dengan ekstensi .mix akan disimpan ke lokasi yang ditentukan.Saving 

to an Audio File

Menyimpan campuran audio yang dibuat ke file audio akan menghasilkan trek 

audio dari format yang dipilih.

Untuk melakukan itu klik tombol perintah Export Audio   pada Mix Tab. Jendela 

Export Mix to Audio File akan dibuka:
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Select the output audio file format and specify the output audio parameters such 

as Sample Rate (Frequency), Bitrate and the number of Channels.

Pilih format file audio output dan tentukan parameter audio output seperti 

Sample Rate (Frequency), Bitrate, dan jumlah Channels.

Tetapkan lokasi untuk trek audio Anda dan klik tombol OK untuk mulai 

menyimpan.

2)	 Labeling, cover, dan packing.

3)	 Uji Coba dan Evaluasi Siaran Pedesaan.

1)	 Lakukan tahap pertama, pada tahap ini disebut juga sebagai tahap pengujian 

alpha (alpha test) yang pengujiannya dilakukan oleh pembuat atau lingkungan 

pembuatnya sendiri.

	Pada tahap ini, salah satu metode yang dugunakan adalah dengan dilakukan 

pengujian menggunakan blackbox testing (Pengujian berfokus pada 

persyaratan fungsional perangkat lunak). 

	Contoh : Tabel Pengujian Blackbox Testing

Aktivitas Pengujian Hasil diharapkan Hasil Pengujian Kesimpulan

•	 Suara

•	 Musik

•	 Sound effect

Tanpa noise

20 db

Suara sapi

Tanpa noise

15 db

Suara sapi

[ x ] Diterima

[    ] Ditolak

[    ] Diterima

[  x ] Ditolak

[ x ] Diterima

[    ] Ditolak

Dst …

	Lakukan pengujian ulang apabila hasil masih ditolak (tidak sesuai hasil yang 

diharapkan)

2)	 Lakukan tahap pengujian beta yang dilakukan dan melibatkan penggunaan 

akhir. 
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	Pada tahap ini, salah satu metode yang dugunakan adalah dengan dilakukan 

pengujian menggunakan Model Evaluasi Sadiman

	Contoh : Model Model Evaluasi Sadiman

4)	 Penyerahan ke bagian penyiaran (Radio, Studio).

7.	 Tugas dan Pertanyaan :

Untuk memperdalam uraian materi siaran pedesaan, lakukanlah kegiatan berikut:

a.	 Dari kelompok yang sudah terbentuk, yaitu perkelompok 3 orang.

1)	 Pelajari dan pahami uraian materi pada Modul Media Penyuluhan Pertanian!

2)	 Putarlah dan dengarkan contoh Siaran Radio/Pedesaan yang telah disediakan

3)	 Diskusikan hasil pengamatan Siaran Radio/Pedesaan yang telah diputar, untuk 

menjawab pertanyaan-pertanyaan, sebagai berikut :

a)	 Siaran pedesaan yang tadi telah diputar (didengarkan), termasuk kepada 

bentuk acara siaran pedesaan apa ? 

Alasan : ……………………………………………………………….....................................

……………………………………………………………………………………………………………….

b)	 Apakah isi materi yang disampaikan sudah sesuai dengan judul?

Alasan : ……………………………………………………………….....................................

……………………………………………………………………………………………………………….

c)	 Bagaimana caranya menentukan topik dan judul dari materi siaran pedesaan 

yang akan disiarkan disuatu daerah (wilayah) yang akan menjadi lokasi 

penyuluhan ?

Caranya : ………………………………………………………………………………...................

……………………………………………………………………………………………………………….

d)	 Apakah isi materi yang disampaikan sudah sesuai dengan dengan tujuan yang 

ingin dicapai ?

Alasan : ……………………………………………………………….....................................
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……………………………………………………………………………………………………………….

e)	 Apakah informasi yang disampaikan pada siaran pedesaan tersebut mudah 

dipahami ?

Alasan : ……………………………………………………………….....................................

……………………………………………………………………………………………………………….

f)	 Apakah inovasi teknologi yang menjadi bahan informasi pada sisran pedesaan 

tersebut dapat diterapkan oleh sasaran (petani) ?

Alasan : ……………………………………………………………….....................................

……………………………………………………………………………………………………………….

g)	 Apakah cara penyajian (pengemasan) siaran pedesaan tersebut  sudah sesuai 

dengan sasaran pendengar ?

Alasan : ……………………………………………………………….....................................

……………………………………………………………………………………………………………….

h)	 Apakah kualitas suara siaran pedesaan tersebut sudah layak untuk disiarkan 

atau diperdengarkan kepada publik (sasaran penyuluhan) ?

Alasan : ……………………………………………………………….....................................

……………………………………………………………………………………………………………….

i)	 Apakah teknik penyusunan isi materi pada siaran pedesaan tersebut sudah 

baik dan benar ?

Alasan : ……………………………………………………………….....................................

……………………………………………………………………………………………………………….

4)	 Deskripsikan (berikan gambaran) berupa tulisan hasil diskusi tersebut !

5)	 Presentasikan tulisan hasil diskusi (deskripsi), dengan ketentuan waktu 

presentasi akan disesuaikan.

8.	 Pustaka :

Anonimous, 2002. Buku Standar Teknis Media Penyuluhan Pertanian. Badan 

Pengembangan SDM Pertanian. Jakarta 2002
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Anonimous, 2001, Buku Media Visual Dalam Pelatihan dan Penyuluhan I dan II. 

Pusat Manajemen Pengembangan SDM Pertanian.

Anonimous, 2008. Pemanfaatan Media Dalam Pembelajaran (Buku Ajar). 

Pendidikan dan Latihan Profesi Guru (PLPG) Sertifikasi Guru Dalam Jabatan 

Tahun 2008. Universitas Negeri Semarang. Semarang.

Arifin Y., dkk. 2015. Digital Multimedia. Bina Nusantara Media & Publishing. PT. 

Widya Inovasi Nusantara. DKI Jakarta.

Arsyad Azhar, 2005. Media Pembelajaran. P.T. Raja Grafindo Persada. Jakarta.

Atmaja Yoga, Aziz A., Topatimasang., 2007. Video Komunitas. Memahami, 

Membuat, Mengginakan dan Mengembangkan Video Sebagai Media 

Pendidikan Masyarakat Dan Pengorganisasian Masyarakat. InsistPress. 

Sleman, Jogyakarta

www.avs4you.com, 2004-2011. AVS4YOU Programs Help. AVS Audio Editor. © 

Online Media Technologies, Ltd., UK. 2004 - 2011 All rights reserved

Benny, Dewi, dan Agus. 2005. Ragam Media Dalam Pembelajaran. Buku 2.07. PAU-

PPAI-UT. Jakarta.

Binanto, I. 2010. Multimedia Digital. Dasar Teori dan Pengembangannya. Penerbit 

Andi Yogyakarta.

Munir, 2012. Multimedia. Konsep dan Aplikasi dalam Pendidikan. Penerbit Alfabeta, 

Bandung.

Padmowihardjo Soedijanto, Dr. Ir. 2001. Modul Media Penyuluhan Pertanian. Pusat 

Penerbitan Universitas Terbuka. Februari 2001.

Reyvalda R., 2018. Mengenal Adobe Animate CC 2018. Publikasi e-book Pertama-

2018-©Reyki Reyvalda. Lisensi Attribution 4.0 International (CC BY 4.0). 

Riyanto Bambang, 1998. Diktat Panduan Praktek Media Penyuluhan Partanian. 

Akademi Penyuluhan Pertanian malang.

Sadiman Arief S. Dr. Msc. Dkk. 1993. Media Pendidikan. Pengertian, Pengembangan, 

dan Pemanfaatannya. PT. Raja Grafindo Persada. Jakarta.
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Sanjaya, W. 2012. Media Komunikasi Pembelajaran. Kencana Prenada Media 

Group. Jakarta.

Sudjana Nana, Dr. Rivai Ahmad, Drs. 2005. Media Pengajaran Penggunaan dan 

Pembuatannya. Sinar Baru Algensindo. Bandung.

Sulaeman Amir Hamzah, 1985. Media Audio-Visual Untuk Pengajaran, Penerangan, 

dan Penyuluhan. Penerbit PT Gramedia Jakarta.

Surdjono HD., 2017. Multimedia Pembelajaran Interaktif. Konsep dan 

Pengembangan. UNY Press. 

Wibawanto W., 2017. Desain dan Pemrograman Multimedia Pembelajaran 

Interaktif. Penerbit Cerdas Ulet Kreatif. Jember-Jawa Timur.

www.avs4you.com, 2004-2011. AVS4YOU Programs Help. AVS Audio Editor. © 

Online Media Technologies, Ltd., UK. 2004 - 2011 All rights reserved

9.	 Hasil Praktikum :

a.	 Kelompok : Naskah dan Siaran Pedesaan dalam bentuk CD, file Audio, dan 

lainnya)

b.	 Individu : makalah/tulisan.
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BUKU PETUNJUK PRAKTIKUM 

MEDIA PENYULUHAN 

Minggu ke : IX-XI

Capaian Pembelajaran Khusus : Mampu menetapkan ide/gagasan, dan 

membuat media video penyuluhan/vlog 

penyuluhan pertanian.

Waktu : 3x3x120 menit

Tempat : Lab Media Penyuluhan Pertanian

1.	 Pokok Bahasan :

a.	 Menetapkan ide/gagasan pembuatan Video/Vlog Penyuluhan Pertanian

b.	 Membuat Video/Vlog Penyuluhan Pertanian

c.	 Memproduksi Video/Vlog Penyuluhan Pertanian

2.	 Indikator Pencapaian :

a.	 Mahasiswa mampu membuat ide/eksplorasi gagasan dalam pembuatan 

Video/Vlog Penyuluhan Pertanian

b.	 Mahasiswa mampu membuat Naskah Video/Vlog Penyuluhan Pertanian

c.	 Mahasiswa mampu melakukan pengambilan gambar dan suara  (Shooting)

d.	 Mahasiswa mampu melakukan editing, rendering dan produksi Video/Vlog 

Penyuluhan Pertanian

3.	 Teori :

Berdasarkan penelitian, media video pada umumnya mampu mengingat 50% 

dari apa yang mereka lihat dan dengar. Media video/vlog ini dapat meningkatkan 

pemahaman terhadap suatu materi atau informasi lebih cepat dibandingkan 

dengan media lain.  Penyebabnya adalah pada media video/vlog  pesan lebih 

banyak disampaikan dalam bentuk gambar sedangkan suara hanya berperan 

sebagai pendukung gambar. Isi pesan yang terkandung dalam cerita dapat dilihat 
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dari alur cerita, kejelasan isi cerita, kemenarikan cerita, dan narasi pesan cerita. 

Lebih efektifnya lagi bila penyuluh dalam kegiatan penyuluhannya sebelum 

memutarkan video/vlog diberikan pendahuluan atau pemaparan sedikit tentang 

materi penyuluhan yang akan diajarkan dan diberi penguatan setelah video/vlog 

ditayangkan.

Media video/vlog dapat dimanfaatkan untuk kegiatan proses belajar dalam 

penyuluhan sehingga dapat meningkatkan pemahaman terhadap materi 

penyuluhan yang ingin disampaikan oleh penyuluh kepada para petani. 

Saat ini mudah dan banyak ditemukan media video/vlog pembelajaran di media 

sosial khsusnya di Chanel You Tube, dan yang lainnya. Pembuatan media ini 

tidaklah terlalu sulit, yang penting ada kemauan dan semangat untuk berkarya. 

Hampir setiap orang dapat membuat media video/vlog penyuluhan, yang 

membedakan yaitu kualitas dan kebermanfaatan dari hasilnya.

4.	 Bahan dan Alat :

No. Bahan dan Alat Gambar
Keterangan/ 

kegunaan

1. Kamera video/HP 

Android
Kamera video       

Handphone/

HP Android

Shooting

2. Stabilizer Holder, 

Misalnya:  tongsis, 

tripod, monopod, 

gorilla pod, hingga tri 

axis camera/ phone 

holder (steady cam).

Menghasilkan 

gambar yang stabil 

untuk kualitas 

terbaik

59MEDIA PENYULUHAN

BUKU PETUNJUK PRAKTIKUM



No. Bahan dan Alat Gambar
Keterangan/ 

kegunaan

3. External Microphone, 

Misalnya:  clip 

microphone,  voice 

recorder, ataupun 

jenis shotgun

Lebih jernih dan 

akurat dalam 

menangkap 

audio.

4. Lighting Gear, 

Misalnya:  video 

lighting,  reflector, 

dan diffuser.

Pencahayaan 

buatan

5. Headphone Alat bantu dengar 

6. Komputer/Laptop Editing, rendering, 

dan produksi

7. Printer Mencetak naskah 

video/vlog

8. Alat tulis dan kertas Membuat naskah 

dan story board
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No. Bahan dan Alat Gambar
Keterangan/ 

kegunaan

9. Software Editing Video  

dan Vlog
AVS                     

Video     

Editor        

Film 

OraGo

Program pembuat 

video

Program pembuat 

vlog

5.	 Organisasi :

Pengorganisasian kegiatan pembelajaran praktikum pembuatan media video/vlog 

penyuluhan dalam pembagian perannya, sebagai berikut: 

a.	 Kelompok

1.	 Pembagian kelompok, masing-masing kelompok berjumlah 3 orang.

2.	 Masing-masing kelompok mendiskusikan tahapan pelaksanaan praktikum 

yaitu: 1) perencanaan, 2) pengembangan, 3) pelaksanaan dan 4) produksi, 

dan 5) evaluasi video/vlog penyuluhan pertanian.

3.	 Masing-masing kelompok membuat laporan pelaksanaan praktikum 

pembuatan video/vlog penyuluhan pertanian.

4.	 Masing-masing kelompok mengumpulkan hasil produksi pembuatan media 

video/vlog penyuluhan pertanian berupa: 1) naskah, dan 2) hasil produksi 

video/vlog penyuluhan pertanian.

b.	 Individu

1.	 Setiap mahasiswa melakukan pendalam materi tentang video/vlog penyuluhan 

pertanian (tugas mandiri).

2.	 Materi pendalaman (tugas dan pertanyaan) dapat dilihat pada poin subbab 7 

di bawah.
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3.	 Setiap mahasiswa membuat laporan berupa tulisan/makalah hasil pendalaman 

materi video/vlog penyuluhan pertanian.

4.	 Makalah diserahkan kepada dosen pengampu mata kuliah.

Dalam proses kegiatan pembelajaran ini seluruh pekerjaan didisribusikan dengan 

pembagian peran kerja masing-masing dari mahasiswa, dosen, dan PLP sebagai 

berikut:

	Mahasiswa, diantaranya: 

1)	 Pemilihan dan penetapan ide/gagasan

2)	 Pembuatan konsep serta desain media 

3)	 Mengerjakan produksi media 

4)	 Melakukan uji coba dan evaluasi

5)	 Produksi media 

6)	 Mempresentasikan produksi media 

	Dosen, diantaranya: 

1)	 Merancang hasil produksi media  (pemilihan atau pesanan)

2)	 Memonitor proses pengerjaan produksi media  

3)	 Melakukan penilaian 

	Pranata Laboratorium Pendidikan (PLP), diantarnya :

1)	 Membantu dosen dan mahasiswa dalam pengoperasian peralatan praktikum 

di laboratorium

2)	 Membantu dosen dan mahasiswa dalam penerapan metode kerja peralatan 

praktikum laboratorium.

62 MEDIA PENYULUHAN

BUKU PETUNJUK PRAKTIKUM



6.	 Prosedur Kerja :

Gambar Prosedur Kerja Pembuatan Media Video/Vlog Penyuluhan Pertanian

Tahapan Pembuatan Media Video/Vlog Penyuluhan Pertanian

a.	 Pembentukan Kelompok Kerja

Pekerjaan ini dilaksanakan oleh kelompok sebanyak 3 orang, berperan sebagai 

produser, penulis naskah, sutradara, pemeran, tim pelaksana, editing, dan 

produksi.

b.	 Penentuan Ide/Gagasan. 

Buatlah terlebih dahulu rancangan pembuatan media video/vlog penyuluhan 

sebaiknya ide diambil dari hasil identifikasi potensi wilayah atau need assesment. 

Sebagai contoh berikut ini:

	TOPIK : Pengolahan Sisa Hasil Peternakan

	GAGASAN : Ternyata paru sapi yang sebelumnya sering 
digunakan sebagai campuran pada sayur gulai 
jeroan dan mempunyai nilai ekonomis rendah. 
Dengan inovasi teknologi hasil ternak maka paru 
sapi dapat meningkat nilai ekonomisnya yaitu 
dengan diolah menjadi Kripik Paru Sapi.
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	TUJUAN  1    : o	 Untuk meningkatkan pengetahuan dalam hal 
inovasi pengolahan hasil yang mudah dan 
murah. 

o	 Maka bentuk yang dipilih adalah video 
pembelajaran  (instruksional video) 

o	 Menjelaskan tahap demi tahap proses 
pembuatan kripik paru sapi.

	TUJUAN  2 : o	 Untuk memperlihatkan pemanfaatan dan 
peningkatan nilai ekonomi dari paru sapi 
kepada masyarakat.

o	 Maka bentuk yang dipilih adalah video 
dokumenter 

o	 Menceritakan keadaan sebelum dan sesudah 
paru sapi dapat diolah menjadi kripik paru sapi.

	MANFAAT  : 1.	 Masyarakat dapat membuat kripik paru sapi
2.	 Masyarakat dapat memanfaatkan bahan sisa 

hasil ternak berupa paru sapi menjadi kripik 
paru yang dapat meningkatkan pendapatan.

	JUDUL : 1.	 MEMBUAT KRIPIK PARU SAPI
2.	 MENINGKATKAN NILAI EKONOMIS PARU SAPI

c.	 Penulisan Naskah.

Ikuti langkah-lahkah berikut dalam pembuatan naskah video penyuluhan/vlog 

penyuluhan pertanian.

	Pilihlah salah satu bentuk program berikut : 

1)	 Drama

2)	 Dokumenter

3)	 Talk show

4)	 Demo

5)	 Musikal

6)	 Quiz, dan 

7)	 Features.
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	Pilihlah format penulisan naskah dua kolom untuk skenario

Contoh : Format naskah dua kolom

	Lakukan visualisasi ide dalam bentuk : 1) sinopsis, 2) treatment, dan 3) 

skenario. (contoh bisa dilihat di bagian modul) 

d.	 Shooting. 

Pahami dan kauasai terlebih dahulu tata istilah/istilah teknis yang terdapat dalam 

skenario (lihat di Modul Media Penyuluhan Pertanian).

	Persiapkan alat dan perlengkapan yang dibutuhkan pada saat shooting

	Pemilihan pemeran disesuaikan dengan karakter yang dinginkan oleh skenario

	Lakukan diskusi dengan sutradara dan para pemeran untuk menyamakan 

persepsi terhadap keinginan skenario

	Lakukan latihan-latihan pemeranan oleh aktor, artis dan pemeran pendukung.

	Seting lokasi shooting sesuai skenario
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	Lakukan shooting dengan mengikuti arahan sutradara

	Lakukan perekaman gambar dan suara.

Contoh Gambar Suasana Shooting

e.	 Editing, Rendering dan Produksi

Langkah-langkah editing dan rendering video menggunakan AVS Video Editor 

(www.avs4you.com, 2010), sebagai berikut :

1)	 Pastikan aplikasi AVS Video Editor sudah ter-install di PC atau Laptop.

2)	 Buka aplikasi AVS Video Editor, maka akan muncul tampilan seperti gambar di 

bawah ini.
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Gambar 1. Tampilan awal aplikasi AVS Video Editor

3)	 Untuk memulai proyek baru, klik menu “File” > “New Project”.

Gambar 2. Memulai proyek baru

4)	 Sekarang kita akan memasukkan beberapa video yang nantinya akan kita edit 

dengan cara klik menu “File” > “Import Media Library”.
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Gambar 3.1 Import Media Library dengan klik menu File terlebih dahulu

Cara lain dapat juga dengan klik tombol “ + Import” seperti di bawah ini.

Gambar 3.2 Import Media dengan tombol Import

5)	 Selanjutnya kita akan diarahkan untuk memlilih file apa saja yang akan kita 

edit nantinya
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Gambar 4. Browse file mana saja yang akan diedit

6)	 Untuk  memulai  mengedit,  kita  perlu  memindah  file  media  yang  

dikehendaki  menuju Timeline, dengan cara “drag and drop mouse” (tekan 

dan tahan mouse sambil digeser lalu lepas jika dirasa sudah sampai di tempat 

yang dituju), sesuai urutan yang kita rencanakan

Gambar 5 Memindah file media menuju timeline
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7)	 Setelah berhasil memindah file media, maka timeline di bagian bawah 

tersebut akan menjadi seperti ini

Gambar 6. Hasil timeline setelah memindah file media

8)	 Edit durasi atau timing video dan adegan (bagian) mana saja yang akan kita 

potong atau hilangkan dengan cara drag ke kanan atau kiri tepat di garis kuning 

pada masing-masing ujung file video yang terdapat pada Timeline. Harap 

cermati dengan saksama saat akan memotong bagian video agar momen-

momen yang diinginkan tidak ikut terpotong.

Gambar 7. Edit video dengan cara drag bagian-bagian yang tidak diinginkan

70 MEDIA PENYULUHAN

BUKU PETUNJUK PRAKTIKUM



9)	 Jika sudah mahir dalam hal potong-memotong bagian video, maka kita dapat 

menuju ke proses selanjutnya agar video yang kita buat menjadi lebih menarik 

dengan menambahkan Transitions, Video Effects, Text, Voice, serta Disc Menu.

Gambar 8. Tampilan pilihan fitur untuk menjadikan video lebih menarik

10)	 Fitur “Transitions” memiliki banyak pilihan transisi dan berfungsi sebagai efek 

pergantian dari satu video ke video lainnya agar terkesan smooth atau halus. 

Pilih efek transisi yang diinginkan lalu drag and drop mouse 10ember10 tanda 

“>” sebagai pemisah masing-masing video.

Gambar 9. Tampilan fungsi fitur “Transitions”

11)	 Fitur “Video Effects” memiliki beragam pilihan yang berfungsi untuk 

memberikan efek- efek pada video. Jika  kita  ingin  menambahkan  efek-efek  

tersebut  pada  video  kita,  maka  kita  harus menambahkan  secara  manual  

terlebih  dahulu  dengan  cara klik kanan  pada  efek yang dipilih, maka akan 

muncul perintah “Add or Replace Video Effect. Selanjutnya  tinggal  mengatur  

seberapa  panjang effect tersebut  berjalan sesuai  dengan selera kita.
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Gambar 10. Tampilan fungsi fitur “Video Effects”

12)	 Fitur “Text” memiliki banyak efek teks yang fungsinya untuk memberikan 

tulisan pada video. Cara menambahkan teks pada video sama dengan cara 

untuk menambahkan video effect seperti pada langkah sebelumnya.

Gambar 11. Tampilan fungsi fitur “Text”

13)	 Fitur “Voice” berfungsi untuk merekam audio atau menambahkan suara ke 

dalam video (jika dirasa perlu). Agar fungsi fitur tersebut berfungsi, maka kita 

memerlukan perangkat audio seperti microphone atau headset/headphone.  

Jika perangkat audio tersebut sudah terpasang, klik tombol “Start Recording”.
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Gambar 12. Tampilan fungsi fitur “Voice”

14)	 Fitur “Disc Menu” untuk 13ember efek lain pada video seperti ditambah  

background, layout, dan lain-lain.

Gambar 13. Tampilan fitur “Disc Menu”

15)	 Klik tombol “Play” untuk sewaktu-waktu menjalankan hasil keseluruhan video 

yang telah diedit.

Gambar 14. Tombol play untuk melihat hasil video keseluruhan yang telah diedit
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16)	 Jangan lupa untuk menyimpan proyek ini terlebih dahulu agar tidak hilang 

dengan cara klik menu “File” > “Save Project As” (jika sama sekali belum 

pernah menyimpan dan memberi  nama  file),  atau  pilih  “Save  Project”  

(jika  sebelumnya  kita  sudah  pernah menyimpan serta memberi nama file).

Gambar 15. Cara menyimpan project

17)	 Jika proyek sudah tersimpan dan dirasa sudah selesai dalam mengedit video, 

maka inilah saatnya kita meng-convert video menjadi “movie” atau video 

yang sudah  menjadi satu kesatuan agar nantinya dapat diputar menggunakan 

pemutar video (video player) seperti K-Lite, VLC, GOM Player, Media Player 

Classic, dan sebagainya dengan cara klik menu “File” > “Produce” (Ctrl +P).

Gambar 16. Cara mem-produce video yang sudah diedit melalui menu File
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Cara lain untuk mem-produce video dapat juga dengan menekan fitur “Produce” 

seperti di bawah ini.

Gambar 17. Cara mem-produce video yang sudah diedit melalui fitur Produce

18)	 Setelah kita menekan tombol “Produce”, maka akan muncul tampilan seperti 

di bawah ini, lalu kita pilih saja yang bertuliskan “File” lalu klik “Next”

Gambar 18. Tampilan awal setelah kita pilih fitur Produce

19)	 Selanjutnya kita pilih format yang kita inginkan untuk video tersebut. Jika 

nantinya video akan diputar di PC/laptop saran saya pilih format AVI saja, 

karena AVI merupakan format video yang paling banyak digunakan. Di 

sebelah kanan kotak Profile terdapat pilihan Advanced, yakni berfungsi untuk 

mengatur kualitas  dari  video  tersebut,  semakin  tinggi  kita  mengatur,  

maka   semakin  bagus kualitasnya. Namun, jika kalian belum mengerti cara 

mengaturnya, lebih baik tidak usah diatur, biarkan saja sesuai pengaturan dari 

pabrik (setting default).
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Gambar 19. Pilihan format video lanjutan dari fitur Produce

20)	 Sekarang  kita telah  masuk  ke tahap  terakhir,  yaitu 18memberi  nama  file 

video  yang diinginkan dan memilih lokasi tempat penyimpanan outputnya. 

Setelah itu  klik tombol “Create”  dan  tunggu  beberapa  saat  hingga  proses  

“rendering”  selesai.  Lama  proses tersebut tergantung dari durasi video yang 

kita edit.

Gambar 20. Tampilan saat proses rendering video
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f.	 Uji Coba dan Evaluasi  Video/Vlog Penyuluhan Pertanian

1)	 Lakukan tahap pertama, pada tahap ini disebut juga sebagai tahap pengujian 

alpha (alpha test) yang pengujiannya dilakukan oleh pembuat atau lingkungan 

pembuatnya sendiri.

	Pada tahap ini, salah satu metode yang dugunakan adalah dengan dilakukan 

pengujian menggunakan blackbox testing (Pengujian berfokus pada 

persyaratan fungsional perangkat lunak). 

	Contoh : Tabel Pengujian Blackbox Testing

Aktivitas Pengujian
Hasil 

diharapkan
Hasil Pengujian Kesimpulan

•	 Frequensi gambar 

•	 Rasio tinggi-lebar

•	 Resolusi Video

25 fps

4:3

1280x720

25 fps

4:3

640x480

[ x ] Diterima

[    ] Ditolak

[ x ] Diterima

[    ] Ditolak

[    ] Diterima

[ x ] Ditolak

Dst …

	Lakukan pengujian ulang apabila hasil masih ditolak (tidak sesuai hasil yang 

diharapkan)

2)	 Lakukan tahap pengujian beta yang dilakukan dan melibatkan penggunaan 

akhir. 

	Pada tahap ini, salah satu metode yang dugunakan adalah dengan dilakukan 

pengujian menggunakan Model Evaluasi Sadiman

	Contoh : Model Model Evaluasi Sadiman

7.	 Tugas dan Pertanyaan :

Untuk memperdalam uraian materi Media Video/Vlog Penyuluhan Pertanian, 

lakukanlah kegiatan berikut :

a.	 Setiap mahasiswa ditugaskan untuk :
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1)	 Pelajari dan pahami uraian materi pada Modul Media Penyuluhan Pertanian!

2)	 Putar dan amati contoh video/vlog penyuluhan pertanian.

3)	 Jawablah pertanyaan-pertanyaan, sebagai berikut :

a)	 Video/vlog penyuluhan yang tadi telah diputar (dilihat), termasuk kepada 

bentuk video/vlog penyuluhan apa ?  ……………………………………………………

Alasan : ……………………………………………………………….....................................

………………………………………………………………………………………………………………

b)	 Apakah isi materi yang disampaikan sudah sesuai dengan judul ? …………

Alasan : ………………………………………………………………....................................

………………………………………………………………………………………………………………

c)	 Bagaimana caranya menentukan topik dan judul dari materi video/vlog 

penyuluhan yang akan ditayangkan di daerah (wilayah) yang akan menjadi 

lokasi penyuluhan ?

Caranya : ………………………………………………………………………………...................

………………………………………………………………………………………………………………

d)	 Apakah isi materi video/vlog penyuluhan yang ditayangkan sudah sesuai 

dengan tujuan yang ingin dicapai ? …………………………………………………………

Alasan : ……………………………………………………………….....................................

………………………………………………………………………………………………………………

e)	 Apakah informasi yang disampaikan pada video/vlog penyuluhan tersebut 

mudah dipahami ? ……………………………………………………………………

Alasan : ……………………………………………………………….....................................

……………………………………………………………………………………………………………….

f)	 Apakah inovasi teknologi yang menjadi bahan informasi pada video/vlog 

penyuluhan tersebut dapat diterapkan oleh sasaran (petani) ? …………………

Alasan : ………………………………………………………………........................................

……………………………………………………………………………………………………………….
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g)	 Apakah cara penyajian (pengemasan) video/vlog penyuluhan tersebut  sudah 

sesuai dengan sasaran pendengar ? ……………………………………………….

Alasan : ……………………………………………………………….....................................

………………………………………………………………………………………………………………

h)	 Apakah kualitas suara video/vlog penyuluhan tersebut sudah layak untuk 

ditayangkan kepada publik (sasaran penyuluhan) ? …………………………………

Alasan : ………………………………………………………………........................................

……………………………………………………………………………………………………………….

i)	 Apakah teknik penyusunan isi materi pada video/vlog penyuluhan tersebut 

sudah baik dan benar ? ……………………………………………………………………………

Alasan : ………………………………………………………………........................................

……………………………………………………………………………………………………………….

b.	 Deskripsikan (berikan gambaran) berupa tulisan hasil jawaban tersebut !
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9.	 Hasil Praktikum :

a.	 Individu     : Tulisan (deskripsi) jawaban tugas 

b.	 Kelompok : 1) Naskah video/vlog penyuluhan pertanian, dan 2) Video/vlog 

penyuluhan pertanian.
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BUKU PETUNJUK PRAKTIKUM 

MEDIA PENYULUHAN

Minggu ke : XII-XIV

Capaian Pembelajaran Khusus : Merancang desain  dan membuat multi 

media interaktif penyuluhan pertanian 

berbasis teknologi computer/laptop dan 

aplikasi android. 

Waktu : 3X3x120 menit

Tempat : Lab Media Penyuluhan Pertanian

1.	 Pokok Bahasan :

a.	 Merancang desain menu multimedia interaktif berbasis teknologi computer/

laptop dan aplikasi android.

b.	 Pembuatan multimedia interaktif berbasis teknologi computer/laptop dan 

aplikasi android.

c.	 Penggunaan multimedia interaktif berbasis teknologi computer/laptop dan 

aplikasi android.

2.	 Indikator Pencapaian :

a.	 Mahasiswa mampu merancang desain penyusunan menu multimedia 

interaktif berbasis berbasis teknologi komputer/laptop dan aplikasi android.

b.	 Mahasiswa menguasai teknik pembuatan multimedia interaktif berbasis 

berbasis teknologi komputer/laptop dan aplikasi android.

c.	 Mahasiswa mampu menguasai prosedur/langkah pembuatan multimedia 

interaktif berbasis berbasis teknologi komputer/laptop dan aplikasi android.

d.	  Mahasiswa mampu memproduksi multimedia interaktif berbasis berbasis 

teknologi komputer/laptop dan aplikasi android.

e.	 Mahasiswa mampu merancang penggunaan multimedia interaktif berbasis 

teknologi komputer/laptop dan aplikasi android dalam pelaksanaan kegiatan 

penyuluhan pertanian.
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3.	 Teori :

Multimedia adalah pemanfaatan komputer untuk membuat dan menggabungkan 

teks, grafik, audio, gambar bergerak (video dan animasi) dengan menggabungkan 

teks link dan tool yang memungkinkan pemakai melakukan navigasi, berinteraksi, 

berkreasi dan berkomunikasi. Penyajian dengan menggabungkan seluruh elemen 

multimedia tersebut menjadikan informasi dalam bentuk multimedia yang dapat 

diterima oleh indera penglihatan dan pendengaran, lebih mendekati bentuk 

aslinya dalam dunia sebenarnya. 

Multimedia interaktif adalah suatu multimedia yang dilengkapi dengan alat 

pengontrol yang dapat dioperasikan oleh pengguna, sehingga pengguna dapat 

memilih apa yang dikehendaki untuk proses selanjutnya. Contoh multimedia 

interaktif adalah pembelajaran interaktif, aplikasi game, dan lainnya. 

Dalam rangka memberikan materi penyuluhan yang lebih dapat diterima oleh 

para petani, maka dalam penyampaian materinyapun perlu menggunakan 

aplikasi teknologi informasi tepat guna yang sesuai kebutuhan dan tuntutan 

zaman, yaitu materi penyuluhan yang dikemas dalam bentuk CD Interaktif atau 

aplikasi android. Dipilihnya media penyuluhan multimedia interaktif ini, untuk 

menjawab semua kesulitan dalam penyampaian materi di mana tidak perlu lagi 

mempersiapkan dan menggunakan berbagai macam piranti untuk satu materi 

penyuluhan. 

Pengembangan multimedia interaktif salah satunya dapat dikembangkan 

berdasarkan model ADDEI. Model ADDIE merupakan suatu konsep dalam 

pengembangan media belajar berbasis pembelajaran instruksional dengan 

tahapan menganalisis (analyze), mendesain (design), mengembangkan (develop), 

menerapkan (implementation), dan mengevaluasi (evaluation). Mengembangkan 

media penyuluhan dengan proses ADDIE akan efektif karena ADDIE memiliki 

proses yang berfungsi sebagai panduan kerangka kerja untuk situasi yang 

kompleks. Dalam pendekatan penyuluhan, filosofi untuk penerapan ADDIE 

ini adalah bahwa penyuluhan tidak bersifat mendidik, membatasi, pasif, dan 

tunggal, akan tetapi harus terpusat pada penerima manfaat, inovatif, otentik, dan 

inspiratif (Branch, 2009). 
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4.	 Bahan dan Alat :

No. Bahan dan Alat Gambar
Keterangan/ 

kegunaan

1. Kamera video/HP 

Android

Kamera video

Handphone/

HP Android

Shooting

2. Stabilizer Holder, 

Misalnya:  tongsis, 

tripod, monopod, 

gorilla pod, hingga 

tri axis camera/ 

phone holder (steady 

cam).

Menghasilkan 

gambar yang 

stabil untuk 

kualitas 

terbaik

3. External Microphone, 

Misalnya:  clip 

microphone,  voice 

recorder, ataupun 

jenis shotgun

Lebih jernih 

dan akurat 

dalam 

menangkap 

audio.

4. Lighting Gear, 

Misalnya:  video 

lighting,  reflector, 

dan diffuser.

Pencahayaan 

buatan

5. Headphone Alat bantu 

dengar 
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No. Bahan dan Alat Gambar
Keterangan/ 

kegunaan

6. Komputer/Laptop Editing, 

rendering, dan 

produksi

7. Printer Mencetak 

konsep, 

dan dok 

multimedia

8. Alat tulis dan kertas Membuat 

naskah dan 

story board

9. Software Adobe 

Animate cc 2018

Program untuk 

membuat 

multimedia 

interaktif

5.	 Organisasi :

Pengorganisasian kegiatan pembelajaran praktikum pembuatan media video/vlog 

penyuluhan dalam pembagian perannya, sebagai berikut: 

a.	 Kelompok

1.	 Pembagian kelompok, masing-masing kelompok berjumlah 3 orang.

2.	 Masing-masing kelompok mendiskusikan tahapan pelaksanaan praktikum 

yaitu: 1) perencanaan, 2) pengembangan, 3) pelaksanaan dan 4) produksi, 

dan 5) evaluasi multimedia penyuluhan pertanian.
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3.	 Masing-masing kelompok membuat laporan pelaksanaan praktikum 

pembuatan multimedia penyuluhan pertanian.

4.	 Masing-masing kelompok mengumpulkan hasil produksi pembuatan 

multimedia penyuluhan pertanian berupa: 1) naskah , dan 2) hasil produksi 

video/vlog penyuluhan pertanian.

b.	 Individu

1.	 Setiap mahasiswa melakukan pendalam materi tentang multimedia 

penyuluhan pertanian (tugas mandiri).

2.	 Materi pendalaman (berupa pertanyaan dan tugas) dapat dilihat pada poin 

subbab 7 di bawah.

3.	 Setiap mahasiswa membuat laporan berupa tulisan/makalah hasil pendalaman 

materi multimedia penyuluhan pertanian.

4.	 Makalah diserahkan kepada dosen pengampu mata kuliah.

Dalam proses kegiatan pembelajaran ini seluruh pekerjaan didisribusikan dengan 

pembagian peran kerja masing-masing dari mahasiswa, dosen, dan PLP sebagai 

berikut:

	Mahasiswa, diantaranya: 

1)	 Merancang konsep desain multimedia

2)	 Pembuatan konsep desain multimedia 

3)	 Pembuatan multimedia 

4)	 Merancang penggunaan multimedia 

5)	 Mempresentasikan produk multimedia 

	Dosen, diantaranya: 

1)	 Merancang hasil produksi multi media  (pemilihan atau pesanan)

2)	 Memonitor proses pengerjaan produksi multimedia  

3)	 Melakukan penilaian hasil produk multimedia

86 MEDIA PENYULUHAN

BUKU PETUNJUK PRAKTIKUM



	Pranata Laboratorium Pendidikan (PLP), diantarnya :

1)	 Membantu dosen dan mahasiswa dalam pengoperasian peralatan praktikum 

di laboratorium

2)	 Membantu dosen dan mahasiswa dalam penerapan metode kerja peralatan 

praktikum laboratorium.

6.	 Prosedur Kerja :
 

Pembagian 
Kelompok

Kelompok 
merancang dan 

membuat konsep 
desain mul media

Bimbingan Dosen
Iden kasi dan 

Analisis Kebutuhan 
Media

Bimbingan DosenPengembangan 
MediaBimbingan DosenPelaksanaan 

Pembuatan Media

Evaluasi Media Bimbingan Dosen Presentasi

 
Pemilihan 
Atau 
Pesanan  

 

Pembagian 
Kelompok

Kelompok 
merancang dan 

membuat konsep 
desain mul media

Bimbingan Dosen
Iden kasi dan 

Analisis Kebutuhan 
Media

Bimbingan DosenPengembangan 
MediaBimbingan DosenPelaksanaan 

Pembuatan Media

Evaluasi Media Bimbingan Dosen Presentasi

 
Pemilihan 
Atau 
Pesanan  

Gambar Prosedur Kerja Pembuatan Multimedia Interaktif Penyuluhan Pertanian

Prosedur kerja pembuatan multimedia penyuluhan pertanian berbasis komputer 

dan android dilakukan melalui prosedur PDAC dan model ADDIE dengan 

menggunakan software Adobe Animate CC 2018.

a.	 Pembentukan Kelompok Kerja

Pekerjaan ini dilaksanakan oleh kelompok sebanyak 3 orang, berperan sebagai 

produser, penulis naskah, sutradara, pemeran, tim pelaksana, editing, evaluasi, 

dan produksi.

b.	 Lakukan identifikasi dan analisis kebutuhan media. 

Gunakan analisis need assessment untuk: 

1)	 Menentukan tujuan dan manfaat multimedia penyuluhan interaktif

2)	 Memilih dan menetapkan pengguna multimedia penyuluhan interaktif

3)	 Mengidentifikasi sumberdaya yang tersedia
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4)	 Merekomendasikan jenis media yang digunakan dan biayanya

c.	 Buatlah design (perancangan) penyusunan menu multimedia interaktif, 

tahapannya sebagai berikut :

1)	 Menetapkan spesifikasi mengenai konsep program, gaya, tampilan, dan 

kebutuhan material / bahan untuk program. 

Jenis : Multimedia Interaktif Penyuluhan Pertanian

Judul : Probiotik dari Bonggol Pisang sebagai Bahan Pakan 

Tambahan Sapi Perah

Tujuan Aplikasi : Mengenalkan dan memberikan pengetahuan dan 

keterampilan pembuatan probiotik dari bonggol 

pisang.

Sasaran : Peternak KSTM 

Layout size : Width 1280 x High 720 pixel

Font/Style/Size : Arial 

Target Output : Flash Player 10.3, Android

Script : ActionScript 3.0, Air Android

Format : .fla, SWF File, Android

Pengembang : Reyki Revalda

2)	 Pilihlah dan tetapkan desain yang akan dibuat berdasarkan tujuan intruksional. 

Perancangan awal dilakukan dengan membuat flowchart dan storyboard. 

	Contoh Flowchart Rencana Multimedia Interakti
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Flowchart Rencana Multimedia Interaktif
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	Contoh Storyboard Multimedia Interaktif

No Gambar Layar Keterangan

1 1.	 Slide disamping muncul setelah 
program dijalankan

2.	 Ukuran frame untuk seluruh slide 
1366x768 pixel

3.	 Warna :
a.	 Warna judul “probiotik dari 

bonggol pisang dengan 
penambahan em-4 sebagai pakan 
aditif sapi perah” menggunakan 
warna putih dengan background 
gambar pemandangan ladang.

b.	 Warna background tombol 
“bantuan”, “tentang aplikasi” dan 
profil pembuat” putih dengan 
warna tulisan hitam

c.	 Warna background tombol 
“lanjut” berwarna hijau muda 
dengan warna tulisan putih.

d.	 Warna animasi sapi dan peternak 
disesuaikan

4.	 Tipe font: judul “Badaboom”, Tombol-
tombol yang ada “Google Sans”

2 1.	 Slide disamping muncul setelah 
mengklik tombol “lanjut” di slide 
sebelumnya

2.	 Tombol :
a.	 Tombol deskripsi tiap gambar
b.	 Tombol narasi gambar
c.	 Tombol navigasi sebelumnya untuk 

kembali ke slide sebelumnya
d.	 Tombol navigasi home untuk 

kembali ke slide awal
e.	 Tombol navigasi berikutnya untuk 

beralih ke slide berikutnya
3.	 Gambar :

a.	 Terdiri dari 5 gambar jenis-jenis 
pakan sapi perah
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No Gambar Layar Keterangan

b.	 Gambar background “sapi perah 
dengan efek gelap”

4.	 Warna :
a.	 Warna background gelap
b.	 Judul “jenis jenis pakan sapi 

perah” menggunakan warna 
terang

c.	 Background teks deskripsi gambar 
menggunakan warna terang 
dengan teks menggunakan warna 
terang

d.	 Background ikon narasi 
menggunakan warna putih dengan 
warna ikon hitam

e.	 Background tombol-tombol 
navigasi (prev, home, dan next) 
menggunakan warna hijau dengan 
ikon menggunakan warna putih

5.	 Tipe font: Google Sans
6.	 Narasi :

a.	 Hijauan
b.	 Hijauan awetan
c.	 Konsentrat
d.	 Pakan Pelengkap
e.	 Pakan Tambahan

7.	 Interaksi :
Fasilitator mempersilahkan penerima 
manfaat menebak nama-nama jenis pakan 
sapi perah berdasarkan gambar yang 
muncul di slide

3 1.	 Slide disamping muncul setelah 
mengklik tombol “lanjut” di slide 
sebelumnya

2.	 Tombol :
a.	 Tombol deskripsi tiap gambar
b.	 Tombol narasi gambar
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No Gambar Layar Keterangan

c.	 Tombol navigasi sebelumnya untuk 
kembali ke slide sebelumnya

d.	 Tombol navigasi home untuk 
kembali ke slide awal

e.	 Tombol navigasi berikutnya untuk 
beralih ke slide berikutnya 

3.	 Gambar :
a.	 Terdiri dari 5 gambar jenis-jenis 

pakan tambahan sapi perah
b.	 Gambar background sapi perah

4.	 Warna :
a.	 Warna background gelap
b.	 Judul “jenis jenis pakan tambahan 

sapi perah” menggunakan warna 
terang

c.	 Background teks deskripsi gambar 
menggunakan warna terang 
dengan teks menggunakan warna 
terang

d.	 Background ikon narasi 
menggunakan warna hijau dengan 
warna ikon putih

e.	 Background tombol-tombol 
navigasi (prev, home, dan next) 
menggunakan warna hijau dengan 
ikon menggunakan warna putih

5.	 Tipe font: Google sans
6.	 Narasi :

a.	 Jamu ternak
b.	 Prebiotik
c.	 Probiotik
d.	 Antibiotik
e.	 Pakan Tambahan
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No Gambar Layar Keterangan

4 1.	 Slide disamping muncul setelah 
mengklik tombol “lanjut” di slide 
sebelumnya

2.	 Tombol :

a.	 Tombol-tombol menu di samping 
kanan

b.	 Tombol navigasi sebelumnya 
untuk kembali ke slide sebelumnya

c.	 Tombol navigasi home untuk 
kembali ke slide awal

d.	 Tombol navigasi berikutnya untuk 
beralih ke slide berikutnya 

3.	 Gambar : Gambar dilarang 
menggunakan antibiotik

4.	 Animasi : warning flash pada gambar 
antibiotik 

5.	 Warna :

a.	 Warna background merah

b.	 Warna gambar disesuaikan

c.	 Judul “jenis jenis pakan tambahan 
sapi perah” menggunakan warna 
terang

d.	 Background teks menu 
menggunakan warna merah 
dengan teks menggunakan warna 
putih

e.	 Background tombol-tombol 
navigasi (prev, home, dan next) 
menggunakan warna hijau dengan 
tulisan menggunakan warna putih

6.	 Tipe font: Google Sans
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No Gambar Layar Keterangan

5 1.	 Slide disamping muncul setelah 
mengklik tombol “lanjut” di slide 
sebelumnya

2.	 Tombol :

a.	 Tombol-tombol menu di samping 
kanan

b.	 Tombol navigasi sebelumnya 
untuk kembali ke slide sebelumnya

c.	 Tombol navigasi home untuk 
kembali ke slide awal

d.	 Tombol navigasi berikutnya untuk 
beralih ke slide berikutnya 

3.	 Gambar : Gambar probiotik

4.	 Animasi : ceklis pada gambar probiotik 

5.	 Warna :

a.	 Warna background hijau

b.	 Warna gambar disesuaikan

c.	 Judul “jenis jenis pakan tambahan 
sapi perah” menggunakan warna 
putih

d.	 Background teks menu 
menggunakan warna hijau dengan 
teks menggunakan warna putih

e.	 Background tombol-tombol 
navigasi (prev, home, dan next) 
menggunakan warna hijau dengan 
tulisan menggunakan warna putih

6.	 Tipe font: Google sans
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No Gambar Layar Keterangan

6 1.	 Slide disamping muncul setelah 
mengklik tombol “lanjut” di slide 
sebelumnya

2.	 Tombol :

a.	 Tombol probiotik dan antibiotik

3.	 Warna :

a.	 Warna background putih

b.	 Warna gambar disesuaikan

c.	 Judul “pilih yang mana?” 
menggunakan warna putih

d.	 Background teks “probiotik” 
menggunakan warna hijau dengan 
teks menggunakan warna putih

e.	 Background teks “antibiotik” 
menggunakan warna merah 
dengan teks menggunakan warna 
putih

f.	 Background tombol-tombol 
navigasi (prev, home, dan next) 
menggunakan warna hijau dengan 
tulisan menggunakan warna putih

4.	 Tipe font: Google Sans

5.	 Interaksi :

Fasilitator mempersilahkan penerima 
manfaat untuk memilih salah satu dari dua 
pilihan antara probiotik atau antibiotik. 
Jika memilih probiotik maka lanjut ke slide 
berikutnya. Jika memilih antibiotik maka 
aplikasi langsung berhenti
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No Gambar Layar Keterangan

7 1.	 Slide disamping muncul setelah 
mengklik tombol “probiotik” di slide 
sebelumnya

2.	 Tombol :

a.	 Tombol probiotik dan antibiotik

b.	 Tombol navigasi sebelumnya 
untuk kembali ke slide sebelumnya

c.	 Tombol navigasi home untuk 
kembali ke slide awal

3.	 Warna :

a.	 Warna background disesuaikan

b.	 Warna gambar disesuaikan

c.	 Judul “jenis jenis pakan tambahan 
sapi perah” menggunakan warna 
putih

d.	 Background teks menu 
menggunakan warna coklat muda 
dengan teks menggunakan warna 
putih

e.	 Background tombol-tombol 
navigasi (prev, home, dan next) 
menggunakan warna hijau dengan 
tulisan menggunakan warna putih

f.	 Warna tulisan lain disesuaikan

4.	 Tipe font: Google Sans

5.	 Interaksi :

Fasilitator mempersilahkan penerima 
manfaat untuk menebak gambar yang 
menjadi susunan kata. Jika salah maka 
akan keluar tulisan “Salah, ulangi lagi”, jika 
benar makan akan menuju slide berikutnya
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No Gambar Layar Keterangan

8 1.	 Slide disamping muncul setelah 
berhasil melalui tahap dari slide 
sebelumnya

2.	 Tombol :

a.	 Tombol navigasi sebelumnya 
untuk kembali ke slide sebelumnya

b.	 Tombol navigasi home untuk 
kembali ke slide awal

c.	 Tombol navigasi next untuk 
menuju slide berikutnya

3.	 Warna :

a.	 Warna background disesuaikan

b.	 Warna gambar disesuaikan

c.	 Judul “alternatif probiotik” 
menggunakan warna putih

d.	 Background teks menggunakan 
warna putih dengan teks 
menggunakan warna disesuaikan 
warna background

e.	 Background tombol-tombol 
navigasi (prev, home, dan next) 
menggunakan warna hijau dengan 
tulisan menggunakan warna putih

f.	 Warna tulisan lain putih

4.	 Tipe font: Google sans
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No Gambar Layar Keterangan

9 1.	 Slide disamping muncul setelah 
mengklik gambar membuat sendiri 
probiotik di slide sebelumnya

2.	 Tombol :

a.	 Tombol-tombol menu di samping 
kanan

b.	 Tombol navigasi sebelumnya untuk 
kembali ke slide sebelumnya

c.	 Tombol navigasi home untuk 
kembali ke slide awal

d.	 Tombol navigasi berikutnya untuk 
beralih ke slide berikutnya 

3.	 Gambar : Gambar hasil membuat 
sendiri probiotik

4.	 Warna :

a.	 Warna background coklat gelap

b.	 Warna gambar disesuaikan

c.	 Judul menggunakan warna putih

d.	 Background teks menu 
menggunakan warna coklat muda 
dengan teks menggunakan warna 
putih

e.	 Background tombol-tombol 
navigasi (prev, home, dan next) 
menggunakan warna hijau dengan 
tulisan menggunakan warna putih

5.	 Tipe font: Google Sans

3)	 Tahapan pengembangan (development) multimedia dilakukan sebagai 

implementasi dari flowchart dan stroryboard. Tahapan depolovment  sebagai 

berikut :

a)	 Kumpulkan bahan-bahan yang sesuai dengan kebutuhan multimedia yang 

dikerjakan. Bahan-bahan tersebut antara lain gambar clip art, foto, animasi, 

media grafis, media video/vlog, media audio/siaran pedesaan, dan lain-lain 
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yang dapat dibuat mandiri, diperoleh secara gratis atau dengan pemesanan 

kepada pihak lain sesuai dengan rancangannya. 

b)	 Memilih dan menetapkan aplikasi yang dibutuhkan berupa perangkat keras 

dan lunak. Perangkat keras yang digunakan adalah seperangkat komputer 

atau laptop. Untuk perangkat lunak yang dibutuhkan adalah Windows 8 atau 

Windows 10 sebagai Sistem Operasi, Corel Draw X8 untuk membuat grafis dan 

mengedit gambar pendukung,  dan Adobe Animate cc 2018 untuk membuat 

scene yang akan tampil dalam produk akhir. 

d.	 Melaksanakan (implementation) merupakan proses produksi multimedia 

(Pembuatan/Assembly). 

Tahapan pembuatan multimedia menggunakan aplikasi Adobe Animate cc 2018 

secara sederhana, sebagai berikut :

1)	 Membuka/membuat Workspace.
Untuk Membuat media pembelajaran interaktif sederhana yang dapat diopera-
sionalkan di komputer, klik Air for Desktop 
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Gambar di atas adalah workspace yang muncul setelah mengklik Air For Desktop.

2)	 Cara lain untuk membuat workplace seperti gambar dibawah.

Klik File di menu navigasi kemudian klik New... (atau dengan fungsi shortcut 

CTRL+N)

100 MEDIA PENYULUHAN

BUKU PETUNJUK PRAKTIKUM



Setelah di klik akan muncul kotak dialog seperti gambar dibawah ini

3)	 Pada Tab General, berisi menu-menu untuk membuat workspace dari nol
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4)	 Pada Tab Templates, berisi menu-menu untuk membuat workspace dari nol

5)	 Memilih type keluaran atau hasil akhir. Hasil bisa berbasis computer/laptop 

atau berbasis android.

a)	 Berbasis computer/laptop pilih AIR for desktop

b)	 Berbasis Android pilih AIR for Android

Kali ini yang dipilih adalah AIR for desktop.
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	Mulai dengan mengklik type Air for Desktop, kemudian sesuaikan width 

(lebar scene) dan height (panjang) untuk workspace dimana panjang dan 

lebar tersebut sesuai keinginan anda (untuk tampilan menyesuaikan screen 

windows biasanya minimal 800 X 600 px.

	Frame rate merupakan fungsi frame rate (jumlah bingkai gambar atau frame 

per detik) frame per second. Semakin tinggi Frame rate semakin halus 

animasi yang dihasilkan. Biasanya framerate terbaik 50/60 fps.

	Background color untuk mengatur warna background scene di workspace.

	Apabila anda mengklik menu Make Default, maka settingan tersebut dijadikan 

settingan default setiap anda membuka proyek baru.

Setingan diatas dapat diubah saat sudah membuka proyek/pada saat tahap 

developing/pembuatan animasi.
Setelah selesai klik Ok.

Untuk membuat animasi, Adobe Animate menggunakan fungsi frame, sehingga 

animasi yang timbul merupakan gabungan dari beberapa frame yang dijalankan 

seh- ingga terlihat seperti gambar bergerak.

6)	 Tampilan utama Adobe Animate CC 2018

103MEDIA PENYULUHAN

BUKU PETUNJUK PRAKTIKUM



	Nomor 1: Jendela Dokumen (stage) menampilkan file yang sedang dikerjakan. 

Jendela dokumen dapat di-tab dan dapat dikelompokkan.

	Nomor 2: Panel Kontrol menampilkan opsi untuk alat yang saat ini dipilih. 

dikenal sebagai fungsi properties dan termasuk properti dari elemen yang 

sedang dipilih Panel membantu Anda memantau dan memodifikasi pekerjaan 

Anda.  Contohnya  termasuk  Timeline di Animate.

	Nomor 3: Active Tab, tab workspace diatas bernama Untitled-1 yang artinya 

sedang dib- uka 1 item workspace. Scene 1 adalah layar nomor 1 (Scene nomor 

1) merupakan jendela dokumen pada scene 1. Selebihnya nama scene dan 

tab workspace bisa di ganti nama se- suai keinginan. Anda dapat membuka 

lebih dari 1 workspace dan mengorganisirnya sesuai tab terpilih.

	Nomor 4: Menu navigasi, berisi perintah-perintah tertentu untuk edit, custom, 

dan lain sebagainya.

	Nomor 5: Paling kiri adalah bagian scene yang telah dibuat, edit symbol untuk 

mengedit properti simbol yang telah dibuat, center stage untuk mengatur 

tampilan stage agar posi- si preview berada di tengah (center), percent scale 

untuk mengatur zoom tampilan stage berdasarkan persentase

	Nomor 6: Panel default (bisa disesuaikan dengan di ubah berdasarkan 

tampilan windows yang berisi perintah-perintah shortcut). Gambar nomor 6 

adalah default.

	Nomor 7: Panel Tool, panel yang berisi tool untuk membuat grafis dan 

mengedit grafis distage.

	Nomor 8: Custom panel, disesuaikan berdasarkan keinginan creator. Berisi 

perintah-perintah tertentu.

7)	 Menambah background di Adobe Animate cc 2018.
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Sebelum menambahkan gambar 

background, terlebih dahulu 

buat layer. Layer merupakan 

kumpulan atau lapisan yang 

berfungsi sebagai penempatan 

suatu objek, atau bisa juga di 

sebut sebagai kanvas untuk 

sebuah objek layer dengan 

adanya layer kita akan lebih 

mudah mengedit suatu objek 

tanpa menggangu ob- jek lainya. 

Klik icon new layer

Setelah di klik akan muncul 

layer baru dengan nama 

default “Layer_(n) (penomoran 

otomatis)
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Untuk mempermudah kita 

dalam mengedit, dapat 

mengubah nama layer. Untuk 

kasus saat ini layer di- gunakan 

untuk penempatan background, 

maka kita ganti nama layer_2 

tadi dengan background dengan 

cara double click di judul 

layer, kemudian kita input text 

background seperti gambar 

disamping.

Agar layer background tidak 

menutupi obyek2 yang akan 

dibuat selanjutnya, simpan layer 

background di paling bawah 

dengan klik tahan kemudian 

geser ke timeline layer paling 

bawah (dalam kasus ini digeser 

ke bawah layer_1 hingga muncul 

garis hitam) kemudian lepas.

Jika berhasil, maka layer 

Background akan berada dilist 

paling bawah (seperti gambar 

disamping)

8)	 Untuk menambahkan gambar background, pastikan layer background di 

timeline aktif agar nantinya gambar yang dimasukkan berada pada layer 

back- ground.
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Klik File > Import > Import to Stage (Ctrl+R) untuk mengimpor gambar 

background yang sudah tersedia di memori penyimpanan komputer.

9)	 Setelah mengklik import to stage, akan muncul dialog box seperti digambar. 

Adapun file yang dapat diimport adalah media berekstensi JPEG, PNG, BMP, 

SWF dan masih banyak lagi sesuai dengan kebutuhan. Pada saat ini, penulis 

mengimport gambar padang gembala dengan seekor sapi berekstensi JPEG 

seperti gambar disamping.

Setelah gambar untuk background dipilih, klik ok
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PENTING

Agar sesuai, pastikan gambar background yang diimport harus memiliki ukuran 

yang sama dengan ukuran workspace/stage.

10)	  Apabila gambar untuk background memiliki ukuran sama dengan stage maka 

akan nampak terlihat seperti gambar di bawah ini.

11)	  Mengelola background, sebagai berikut :
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Untuk menyesuaikan gambar back-
ground tadi, dapat menggunakan 
tool free transform tool (Q) yang nan-
tinya dapat diperbesar atau diperke-
cil sesuai selera

Selain itu, kita dapat mengatur size 
gambar yang diimport tadi dengan 
menu position and size, ubah ukuran 
W (width) dan H (height) sesuai den-
gan ukuran stage tadi.

12)	 Menambah teks di Adobe Animate CC 2018.

Untuk menambah tulisan teks judul maupun teks lainnya, pertama-tama 

seperti biasa buat layer baru di bagian timeline (seperti tutorial membuat layer 

background di halaman sebelumnya.
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13)	 Pada kesempatan kali ini, saya ingin membuat teks untuk judul, maka layernya 

diberi nama Teks Judul seperti gambar diatas. Pastikan layer Teks Judul berada 

diatas Background (karena layer background menempati urutan paling 

belakang di stage) agar tidak tertutup layer background.
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14)	 Membuat tombol Navigasi Interaktif sederhana.

Tombol navigasi interaktif adalah tombol untuk peralihan dari frame 1 ke frame 

lainnya atau dari stage 1 ke stage lainnya.

Keyframe adalah frame dimana Anda menentukan perubahan pada tombol atau 

animasi. Pada animasi tween, Anda membuat keyframe hanya pada titik yang 

penting di dalam Timeline. Keyframe ditandai oleh titik di dalam frame. Keyframe 

yang tidak berisi gambar di dalam layer ditandai oleh titik kosong.

Blank Key frame artinya kita mempersiapkan frame kosong untuk diisi objek baru, 

dan apabila kita menggambar objek, blank keyframe tersebut sudah berisi objek. 

Blank keyframe dilambangkan dengan titik bulat putih pada frame.

15)	 Untuk membuat tombol sederhana buat layer baru seperti biasa dengan judul 

disesuaikan dengan nama yang dikehendaki.
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Langkah pertama adalah membuat kotak untuk dialognya. Pilih ikon rectangle 

tool di panel tool kemudian atur warna sesuai kehendak kita.
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Klik 
rectangle 
tool 

Buat kotak 
Sesuai kebutuhan 

16)	 Setelah background untuk tombol dibuat, selanjutnya kita beri judul tombol 

tersebut tepat ditengah bentuk persegi panjang tadu. Untuk membuat judul 

tombol menggunakan text tool.
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	Nomor 1: Klik text tool

	Nomor 2: Properti text tool yang akan diinput meliputi jenis text, style text, 

warna.

   K e kan  
         judul yang  
         dikehendaki 
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Apabila berhasil akan Nampak seperti gambar di bawah ini

17)	 Selanjutnya tekan shift kemudian klik tombol objek persegi panjang tadi dan 

klik text “mulai” agar kedua objek tersebut aktif. Hal ini dilakukan agar obyek 

dan tulisan yang dipilih dibuat menjadi satu obyek yang nantinya berfungsi 

sebagai tombol. Jika Berhasil akan seperti gambar di bawah.

18)	 Setelah kedua item tersebut dipilih kemudian klik kanan di bagian kedua objek 

tersebut lalu pilih convert to symbol atau tekan F8.
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Akan muncul sebuah kotak dialog dengan 

judul “Convert to Symbol”. Kotak dialog 

tersebut berisi :

	Nama obyek : Isikan nama obyek tadi, 

dalam kasus ini, obyek yangf akan 

dibuat diberi nama tombol_menu1, 

selebihnya disesuai-kan dengan 

kebutuhan.

	Type : Pastikan type yang terpilih 

adalah button seperti gambar di 

samping karena tujuan pembuatan 

untuk tombol

Setelah selesai klik Ok.

Setelah di klik OK, maka kedua obyek 

tadi akan berubah menjadi satu jenis 

tombol yang ditandai dengan gambar 

bulat ditengah obyek dengan tanda plus 

di sudut kanan atas (seperti nampak pada 

gambar disamping). Ini berarti sudah 

dapat memberikan fungsi perintah pada 

tombol tersebut.
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19)	 Pemberian nama instansi (instance name).

Setelah dibuat tombol, kemudian penting 

untuk dilakukan yaitu dengan memberikan 

nama instansi (instance name) pada tombol 

tersebut sebagai fungsi perintah nantinya untuk 

memanggil (keperluan bahasa pemrogaman 

Action Script). Pemberian nama instansi tidak 

boleh menggunakan spasi. Untuk     memisahkan 

kata dapat menggunakan dash atau underscore. 

Instance of dibawah button adalah sebagai 

instansi untuk tombol yang diberi nama “tombol_

mulai1” pada saat pembuatan tombol mulai. 

(Dalam kasus ini, pemberian nama tombol dan 

nama instansi sengaja dibuat sama).

20)	 Memberikan Action Script. Perintah Tombol Untuk Membuka Frame Tertentu

Untuk menambahkan fungsi perintah di Adobe Animate CC 2018. Kita tidak 

perlu belajar coding atau bahasa pemrograman terlalu rumit. Di Adobe Animate 

CC 2018, telah disediakan code snippet yaitu code dengan perintah-perintah 

tertentu sehing- ga user hanya tinggal menyesuaikan
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Untuk menambahkan bahasa pemrograman, klik menu Action di sebelah tab 

timeline

Kemudian pilih code snippets
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Di menu code snippets, terdapat beberapa pilihan template code diantaranya 

Action Script, HTML5 Canvas dan WebG

21)	 Untuk memfungsikan tombol tadi agar pindah ke frame selanjutnya, klik 

folder ActionScript > Timeline Navigation > Double Click Terlebih dahulu “Stop 

at This Frame” kemudian “Click to Go to Frame and Stop”

(Perintah Stop at This Frame agar saat dibuka tampilan tidak play terus menerus 

tetapi diam. Perintah Click to Go to Frame and Stop tersebut adalah untuk 

menambahkan perintah apabila tombol diklik, maka berpindah ke frame (n) dan 

berhenti di frame tersebut).
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Kemudian secara otomatis tab actions akan terisi code bahasa pemrograman 

seperti gambar diatas.

Pada kasus ini, kita akan menavigasikan tombol “Mulai” ke frame 5. Anda dapat 

memilih frame berapapun sesuai keinginan anda asalkan setelah diklik tombol 

“Mu- lai” maka akan langsung pergi ke frame tertentu.
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Kembali ke Tab Timeline bagian frame

Tombol “Mulai” tadi berada pada frame ke 1, setelah itu kita telah menambahkan 

script di tombol tersebut untuk pergi ke frame ke 5. (Gambar diatas menunjukkan 

bahwa frame ke 5 masih merupakan Blank Keyframe (frame kosong).

22)	  Membuat Konten di Stage Setelah Klik Tombol “Mulai”

Setelah tombol diberi script, langkah selanjutnya adalah mempersiapkan konten 

yang akan muncul setelah mengklik tombol “Mulai” tadi.

Seperti biasa buat sebuah layer dengan nama tertentu kemudian simpan di 

bagian bawah. Gambar diatas menunjukkan layer baru dengan judul background 

2 yang disimpan paling bawah untuk keperluan layer di frame 5.

Pada tutorial sebelumnya, script yang telah dibuat untuk tombol “Mulai” 

memerintahkan untuk pergi ke frame ke 5 setelah di klik
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Klik kanan di frame nomor 5 pada layer background 2

Kemudian klik insert keyframe
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Kemudian akan muncul blank keyframe

23)	 Untuk menambahkan gambar gunakan perintah File > Import > Import to Stage 

(Ctrl+R) kemudian pilih gambar yang dikehendaki sebagai gambar background 

dan sesuaikan ukurannya.
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Tampilan pada frame ke 5

Pada gambar background 2, klik di frame 5.

24)	  Melihat Preview hasil animasi sebelum diterbitkan (dipublish).

Apabila anda ingin melihat preview hasil karya di Adobe Animate CC 2018 

tentang seperti apa tampilan media setelah dipublish atau mengecek kesalahan, 

anda dapat melihat seperti apa preview media sebelum dipublish dengan fungsi 

preview.
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Untuk melihat preview, klik menu Control > Test (Ctrl+Enter)

Gambar Tampilan preview
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25)	 Mempublish (Menerbitkan) Multimedia Interaktif yang sudah dibuat.

Setelah selesai dibuat jangan lupa untuk menyimpan hasil kerja di Harddisk anda. 

Agar media interaktif dapat dijalankan di komputer anda, export (publish) media 

in- teraktif dengan cara sebagai berikut.

Klik File > Publish Settings...

Maka akan muncul kotak dialog seperti 

gambar disamping

125MEDIA PENYULUHAN

BUKU PETUNJUK PRAKTIKUM



26)	 Tampilan Publish Settings

 

Disesuaikan dengan 

 

Beri nama file anda sesuai keinginan   

Dan  klik  Save untuk  menyimpan
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27)	 Setelah selesai pengaturan, Klik “Publish”

28)	 Tampilan Multimedia Interaktif setalah di buka
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e.	 Testing (pengujian) multimedia Interaktif

1)	 Lakukan tahap pertama, pada tahap ini disebut juga sebagai tahap pengujian 

alpha (alpha test) yang pengujiannya dilakukan oleh pembuat atau lingkungan 

pembuatnya sendiri.

	Pada tahap ini, salah satu metode yang dugunakan adalah dengan dilakukan 

pengujian menggunakan blackbox testing (Pengujian berfokus pada 

persyaratan fungsional perangkat lunak). 

	Contoh : Tabel Pengujian Blackbox Testing.

Aktivitas Pengujian Hasil diharapkan
Hasil 

Pengujian
Kesimpulan

Klik Tombol “Button 

Mulai”

Muncul Frame ke 5 Muncul 

Frame ke 5

[ x ] Diterima

[    ] Ditolak
Dst …

	Lakukan pengujian ulang apabila hasil masih ditolak (tidak sesuai hasil yang 

diharapkan)

2)	 Lakukan tahap pengujian beta yang dilakukan dan melibatkan penggunaan 

akhir. 

	Pada tahap ini, salah satu metode yang dugunakan adalah dengan dilakukan 

pengujian menggunakan Model Evaluasi Sadiman

	Contoh : Model Model Evaluasi Sadiman.
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7.	 Tugas dan Pertanyaan :

Untuk memperdalam uraian materi Multimedia Interaktif Penyuluhan Pertanian, 

lakukanlah kegiatan berikut :

a.	 Setiap mahasiswa ditugaskan untuk :

1)	 Pelajari dan pahami uraian materi pada Modul Media Penyuluhan Pertanian!

2)	 Putar dan amati contoh Multimedia Interaktif Penyuluhan Pertanian.

3)	 Jawablah pertanyaan-pertanyaan, sebagai berikut :

a)	 Mutimedia interaktif penyuluhan yang tadi telah diputar (diamati), termasuk 

kepada bentuk multimedia apa ?  ......................................................................

Alasan : ...............................................................................................................

............................................................................................................................

b)	 Apakah isi materi yang disampaikan sudah sesuai dengan judul ? ....................

Alasan : ...............................................................................................................

............................................................................................................................

c)	 Bagaimana caranya menentukan tujuan, pengguna dan judul multimedia 

interakktif penyuluhan yang akan ditayangkan di daerah (wilayah) yang akan 

menjadi lokasi penyuluhan ? .............................................................................

Caranya : ............................................................................................................

............................................................................................................................

d)	 Apakah isi materi multimedia interaktif penyuluhan yang ditayangkan sudah 

sesuai dengan tujuan yang ingin dicapai ? .........................................................

Alasan : ...............................................................................................................

............................................................................................................................

e)	 Apakah informasi yang disampaikan pada multimedia interaktif penyuluhan 

tersebut mudah dipahami ? ...............................................................................

Alasan : ...............................................................................................................

............................................................................................................................
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f)	 Apakah inovasi teknologi yang menjadi bahan informasi pada multimedia 

interaktif penyuluhan tersebut dapat diterapkan oleh sasaran (petani) ? .........

Alasan : ...............................................................................................................

............................................................................................................................

g)	 Apakah cara penyajian (pengemasan) multimedia interaktif penyuluhan 

tersebut  sudah sesuai dengan sasaran pendengar ? ........................................

Alasan : ...............................................................................................................

............................................................................................................................

h)	 Apakah kualitas suara multimedia interaktif penyuluhan tersebut sudah layak 

untuk ditayangkan kepada publik (sasaran penyuluhan) ? ................................

Alasan : ...............................................................................................................

............................................................................................................................

i)	 Apakah teknik penyusunan isi materi pada multimedia interaktif penyuluhan 

tersebut sudah baik dan benar ? .......................................................................

Alasan : ...............................................................................................................

............................................................................................................................

b.	 Deskripsikan (berikan gambaran) berupa tulisan hasil jawaban tersebut !
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9.	 Hasil Praktikum :

a.	 Multimedia Interaktif Penyuluhan Pertanian Berbasis Komputer/Laptop dan 

Android (kelompok).

b.	 Makalah/tulisan (individu).
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Lampiran 1. Contoh Form Langkah Kerja Perencanaan

Nama : NIRM    : Kelas   :

Pekerjaan : Bahan :

No. Gambar : Jumlah :
	

Nama Pekerjaan :

Konsep/Desain/Rancangan :

Deskripsi :

Tahapan Pekerjaan :

No. Proses Visual Alat Bantu

133MEDIA PENYULUHAN

BUKU PETUNJUK PRAKTIKUM



No. Proses Visual Alat Bantu

Disetujui :

Dosen : PLP/Laboran : Tgl : Paraf  :
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Lampiran 2. Contoh Form Langkah Kerja Pelaksanaan 

Nama :
NIRM               

Tingkat/Jurusan

:

:
Kelas   :

Pekerjaan : Bahan :
No. Gambar : Jumlah :

Nama Pekerjaan :

Konsep/Desain/Rancangan :

Deskripsi :
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Bahan	 :

Ukuran	 :

Jumlah	 :

No. Proses Visual Alat Bantu
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No. Proses Visual Alat Bantu

CATATAN PENTING :
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Lampiran 3. Contoh Form Pentunjuk Pengisian Langkah Kerja Pelaksanaan

PETUNJUK  PENGISIAN LANGKAH KERJA PELAKSANAAN

1. GUNAKAN FORM LANGKAH KERJA PELAKSANAAN 

2. DENGAN MENGGUNAKAN BLOK LETTER ( DI ANJURKAN DENGAN STANDAR 
ISO) atau KOMPUTER 

• Nama : Di isi 3 nama mahasiswa yang bersangkutan 

• Tingkat/Jurusan : Di isi sesuai tingkat/jurusan dari mahasiswa yang 
bersangkutan

• Sektor Kerja : Di isi sesuai dengan tempat sektor kerja

• No Gambar : Di isi sesuai dengan nomor gambar kerja (apabila 
tersedia)

• Alat dan Bahan : Di isi jenis alat dan bahan kerja yang dibutuhkan

• Jumlah : Di isi sesuai dengan jumlah alat dan bahan yang 
akan dibuat.

3. GAMBAR KEMBALI : GAMBAR KERJA SECARA LENGKAP SESUAI DENGAN 
TEKNIK YANG BAIK DAN BENAR PADA TEMPAT UNTUK MENGGAMBAR 
(apabila disediakan)

4. PELAJARI GAMBAR KERJA DENGAN SEKSAMA (apabila disediakan)

5. BUAT PERENCANAAN LANGKAH KERJA PADA KOLOM YANG TERSEDIA 
DENGAN CARA PENGISIAN SBB :

• Kolom No : Di isi dengan nomor urutan langkah pengerjaan

• Kolom Proses : Di isi dengan proses kerja yang direncanakan

• Kolom Visual : Di isi dengan gambar sketsa/foto sesuai proses 
kerja

• Kolom Alat Bahan : Di isi dengan alat dan bahan yang dibutuhkan pada 
setiap proses pekerjaan.

6. SETELAH SELESAI LAPORKAN PADA INSTRUKTUR UNTUK DISETUJUI

Malang, …………………………

Ka Prodi …………………

(…………………………………..)

NIP. 
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PENGESAHAN

Diperiksa oleh Disetujui dan disahkan oleh : 

pada tanggal : pada tanggal : 

DISTRIBUSI 

1 5

2 6

3 7

4 8

RINCIAN  REVISI

Edisi Revisi Bagian Semula berbunyi : Sekarang 
berbunyi :
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Lampiran 4. Contoh Form Laporan Mingguan

Nama : NIRM : Kelas   :

Pekerjaan : Bahan :

No. Gambar : Jumlah :

Nama Pekerjaan  :

Minggu Ke :

Tanggal      :

Kegiatan     : 

Waktu Perkiraan        :

Prosentase Pekerjaan :

Waktu Sebenarnya     :

Catatan Penting/Revisi :

140 MEDIA PENYULUHAN

BUKU PETUNJUK PRAKTIKUM



Visualisasi Bukti Pekerjaan :
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